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Chapter 1-Overview of AWM

What AWM Does

AWM is a planning/design tool for animal feeding operations that can be used to estimate the
production of manure, bedding, process water and determine the size of storage/treatment
facilities. The procedures and calculations used in AWM are based on the USDA-NRCS
Agricultural Waste Management Field Handbook.

AWM uses the concepts of “Manure Master” to produce a gross nutrient balance but does not
track mass or concentration of nutrients for determining land application rates or for other
utilization components.

Features of AWM

= Provides manure characteristics for eight animal types with the ability to modify these
characteristics and add animal types as necessary.

= Accounts for bedding, wastewater, flush water and other additions to the waste stream.

= Tracks liquid and solid wastes produced in multiple locations through multiple waste
streams.

= Develops separation, storage, and treatment components for liquid and solid wastes that
are defined as “Management Trains”.

= Estimate precipitation and runoff entering the “Management Train”..

= Sizes storage facilities using a defined storage period or drawdown dates specified by the
user.

= Develops a monthly water and waste budget for each treatment/storage component.

= Provides a calculator for converting units and performing computations.

= Produces a gross nutrient balance from target yields and crop acreage specified for crops
listed in the crop database.

= Provides a schematic drawing for each treatment/storage component.

= Generates a standard or custom report to document the system design.

User Support

User support can be obtained from the USDA-NRCS National Technology Support Centers.
Contact Bill Reck at (336) 370-3353/ bill.reck@gnb.usda.gov, Darren Hickman at (817) 509-
3303/ darren.hickman@ftw.usda.gov, or Charles Zuller at (503) 273-2423/
charles.zuller@por.usda.gov. Programming support for errors or omissions is provided by
Harbans Lal, who can be reached at (503) 273-2441/ harbans.lal@por.usda.gov.

Future Enhancements

USDA-NRCS solicits the input of users to help determine the priority of potential
enhancements to AWM. Please contact programming support to let us know what
enhancements would be of value to you.

AWM User Guide Page 1


mailto:bill.reck@gnb.usda.gov
mailto:Darren.hickman@ftw.usda.gov
mailto:charles.zuller@por.usda.gov
mailto:harbans.lal@por.usda.gov

Chapter 2 — Installing and
Starting AWM

What You Need to Use AWM

System requirements:
= Any IBM-compatible machine with at least a 400 Mhz processor.
Microsoft Windows 2000/XP
Microsoft Access 2002 or later
At least 128 megabytes of memory
At least 100 megabytes of hard drive storage space

Installation on CCE and Non-CCE Machines

AWM may be installed on both USDA Common Computing Environment (CCE) machines
and non-CCE machines. The AWM installation program will detect whether your machine is
a CCE machine and make necessary adjustments to the installation process. System
administrator privileges will be needed to install AWM.

Installing AWM

AWM is available from the NRCS National Water and Climate Center

1. Download the following files from the USDA-NRCS National Water and Climate
Center, Animal Waste Management webpage:
Www.wcce.nres.usda.gov/awm/awm.html to a temporary directory on your
computer’s hard drive:

o The AWM installation program,.
o The AWM database file, where # is the version number.
o AWM User Guide in MS Word (doc) or Portable Document Format (PDF).

Note: The installation files for the AWM computer program are fairly large so unless
you are connected to a high speed internet connection it strongly recommended that
you request the program be sent to you on CD. Please submit your request to Harbans
Lal, who can be reached at (503) 273-2441 or by email at harbans.lal@por.usda.gov.

2. Execute the installation program by either:
o Double clicking on the install program in Windows Explorer, or
o Clicking Start, select Run, browse to the location of the installation file, select

the install program, and click the button.

Note: You must have system administrator privileges to install AWM.

3. After installing AWM, be sure to follow the instructions on the next page to install
the current database, if necessary. In this manner the most up-to-date information is
used in the program.
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Current Version of the AWM Database

The user can determine the current version of the AWM program and the database installed
by clicking on Help->About in the AWM main menu as shown below:
File Edt Data Yiew Tools Window

Program version:

TC!." Conkents, .. .
il / Database version:

Skark Climate Animals

The following popup window will appear:

w About AWM...

AWM Cwrent Database
m‘ Werzion 2.3.0 “erzion 2.3

Animal “Waste Management [AWh) i & tool developed by Matural Resources Conservation
zervice [NRCS) for its employees and others to use in planning and design of structural
components for agriculiural waste management systems. The program results fram ateam
effart with leadership provided by the MNational WWater and Climate Center. AWy is & complete
rewision of & 1985 DOS program with the same name (by Clint Liezert). The AWM development
team members included:

William H. Boyd - Enviranmental Enainesr, HRCS, Mational '/ ater M anagement Center, Little Fock, AR
J. James Dana - 51. Programmer Analyst/T azk Lead, Anteon, Portland, OR

Stephen Henry - Erwvironmental Enagineer, MRCS, Columbia, S5C

Chance Lerro - Programmer Analyst, &nteon, Portland, OR ; Yancouver, B.C.

Dawid C. Moffitt - Ervironmental Engineer, HECS , Mational ' ater b anagement Center, Fort Wiarth, T
Bruce Mewton - Limrologigt, MRCS, Mational “water and Climate Center, Portland, OR

Dipezh K. Patel - 51, Programmer Analyst, Anteon, Portland, OR

James D. Rickman - Environmental Engineer, M ational Pork Producers Council, Fort Worth, T

Rick Roberson - Information Systems Team Leader, MRCS, Mational '/ ater and Climate Center, Portland, OR
Donald L. Stettler - Environmental Engineer, MRCS, Mational \/ater and Climate Center, Portland, OR
Jody Stringer - Urhan Engineer, MACS, Tulza, OF

Denize Watkins - Supervizam Civil Engineer, MRCS. Chattanooga, TH

Bruce Wilson - Environmental Enaineer, MECS, Mational '/ ater and Climate Center, Partland, OR

special thanks to Yantha Sol-Cham for deweloping the scgrid component used throughout
A, Also, thanks to Eugene Burmeister.

The United States Departrent of Agriculture [1S0A] prohibits discrimination in itz programs on the basiz of race,
color, national origin, =ex, religion, age, dizability, political beliefs and marital or familial statuz. (Mot all prokibited bases
apply to all programz.] Perzonz with dizabilities who require alternative means for communication of program
information [Braille, large print, audio tape, etz.] should contact the LUSDA Office of Communications at [202]
F20-2791.

To file a complaint, write the Secretary of Agriculture, .5, Department of Agriculture W azhington 0.
20250 u:ur_u:all [202] F20-F327 [voice] or [202) 7201127 [TDD). USDA iz an equal employrment
opportunity employer. Svstem Info...

Installing the AWM Database

When AWM is installed it also installs a database containing animal, bedding, climate, and
separator data for each state. The most up-to-date database is located on the AWM website
and should be downloaded, if necessary, and installed to ensure the most up-to-date data will
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be used in developing designs. To download the most current database for AWM, click on
Help->Contents in the AWM main menu as shown below: _
i AWM - Untitled [=1E3
_File Edit D_ata Wig Too_l.s Sindow NaEl] ]

e — ] BEE
e About gg
Start Arimal: ndditions | Caleulakor

The following popup window will appear:
E? AWM Help

& & & O

Hide: Back Frint

United States Department of Agriculture

LContents 1|ndeg ]

— 0 N RC Natural Resources National Water

= VEMVIEW ¥ % -

[ New/Stat Screen A~/ Conservation Service 2and Climate Center

E Climate Screen

a Animal Screen
% Locations Screen

NWCLC Home | About Us | Products | Publications | News | Partnerships | Contact Us

5] Addtions Sereen search Animal Waste Management Software
a “wiash 'water Caloulator Enter Keywords GO

E Fluzh W ater Calculator

£] Runoff Screen i

= Conservation What is AWM?

a tanagement Train Screen

E Design Screen Planning

a Mariirehiader Information AWM AWM is .a planning/design tU.U| for animal feeding Uperatiurfs that ca.n be us
a Editing Database Tables S e By bt are production of manure, beddl.ng, proces.s water and determine the size of st
a Calculatar Managernent e The procedure.s and calculations used in AWM are based on the USDA-NRC
+ Hydraulics & Management Field Handbook,
Hydrology
v Irrigation & Water AWM AWM 115Rs the canrants of "Manire Master” ta nrodoee a arass norrient hal

Click on "AWM Database" in the Contents window to access the AWM database download
site as shown above. Click on AWM Database link to download the most current version of
the AWM database to the folder you select. After downloading the file, perform the
following steps to install the database file for use with the AWM program:

1. Unzip the database file by double clicking it and unzipping the file to a folder.

2. The default directory for AWM is C:\Program Files\USDA\AWM 2.3.0.

w

Replace your existing awm_data.mdb with the new file.

&

The database is now ready to be used with the program.
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Starting AWM

The following instructions explain a few of the ways to start the AWM program:

Any Computer

AWM may be started b chckmg on m

rL Engineeting Applications DML EXE .~ This will open the

program without opening any saved client files.

From Windows Explorer

A previously saved design file may be used to open AWM. From within Windows
Explorer, locate and double-click on a previously saved design file. These files will have
the extension awm (e.g., EImer_Farms.awm)

From the Customer Service Toolkit Client List

Within the USDA Customer Service Toolkit you can browse the client list in Outlook and
determine if the client files include any AWM design files. These will be identifiable by
the .awm extension. Clicking on these files will open AWM with the previously saved
design file.

From the Customer Service Toolkit

Anytime you are working within Customer Service Toolkit on a client you may click on
Tools in the menu bar, click on Engineering Tools, and select AWM. AWM will open
with the client’s name automatically entered. Upon exiting AWM the file will be saved
with the files for that client.

Quitting AWM

From the file menu click on File then Exit,

s AWM - Untitled
SN Edit Data  Wiew Tools  Window  Help

oo || PF [ I | B | A | | & b

Animals Locations Additions Runoff rgmt Train Design I ManureMaster

Reports
Export

Save Chrl+5
Save As...

or press the [Alt] [F] [X] keys on the computer keyboard,
or click on the L& in the upper right-hand corner to exit AWM.
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e The previous action results in the following popup screen:

Press the [Enter] key to
:.i) Save changes before quitting? - select ﬁ or click

Y )
on the appropriate
Yies Mo | Zancel | button.
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Chapter 3 - Navigating
Within AWM

Overview

The process of designing treatment/storage facilities using AWM involves a step-by-step
sequence of screens. When developing an initial design, the sequence of screens in the order
shown on the toolbar must be followed with the exception of the calculator that can be used
within any of the screens.

ol AWM - H:\MAWMMWMComputerPrgmiDesignFiles\AWMUsermManual. awm
File Edit Data WYiew Tools Window Help

%W‘h@iﬁg\ﬁ

Skatt Climate Animals Locations Additions Runoff Calculator | ManureMasker

The screens and their function are as follows:

rgnnk Train Design

Start - On this screen the user defines the client, defines the designer, selects the
sat | Oata source (NRCS, MWPS, etc.), and sets up the operating period(s).

% Climate - On this screen the user defines the monthly climate parameters, the 25-
ama= | YeQr, 24-hour precipitation, and other climate-related factors.

1@ | Animals - On this screen the user selects animal types and enters the number and
aimats | AVErage weights. Animal characteristics may be modified and new animal types
can be defined within this screen.

Locations - On this screen the user defines locations where wastes are generated.
weaions | VV/AStes from different locations may have different additions to the waste stream
and the wastes may be routed through different management trains.

Additions - On this screen the user defines any additions to the waste streams
such as from bedding, waste water, and flush water.

2

-l
o
=N
o
=]
n

Runoff - On this screen the user may elect to allow AWM to calculate runoff
volumes or to enter volumes calculated outside the program.

)

ral
cC
3
=}

£

Management Train - On this screen the user selects a sequence of
treatment/storage components for each waste stream.

4
4
&
]

g
=) B
o =
= = |
= o
=2

Design - On this screen the user specifies the parameters used to size and
calculate the dimensions of treatment/storage components. A monthly waste
stream budget is displayed on this screen.

Calculator - This is a popup screen that can be used within any of the design

cacktr | SCreens to calculate unit conversions and perform other calculations. The

calculator is not available within the ramp design screen. The calculator must be
selected from a separate button within the soil liner design screen.

% | Manure Master - On this screen the user can generate a gross nutrient budget by
manuremzster| SEl€CtING Crops and entering acres and yield data.
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Moving Between Screens

During the initial entry of information the user is moved from screen to screen in

sequence by clicking on the button on each screen.

At any time the user may move to a previously completed screen by clicking on the large
navigation buttons;
‘ ‘ ‘ ‘ ‘ ‘ Caleulakar

When a screen has been completed and the user clicks the ___OK | putton, the next
navigation button will change from gray to colored.

Skart

When a navigation button is in color;

SHR.N

Climake Arimals Locations

(o

&)

Runoff

=

Design

&

Additions

L%

ManureMaster

=
Calculakor

L4300

MMgmk Train

: ‘

Skart

it may be used to move immediately to that screen by clicking on the associated button.
The popup calculator screen is available in any screen so it is always in color.

Any changes to information on a screen will immediately modify values on later screens
if the change affects calculated values.

HELP

Help messages providing information on data entry and the operation of AWM can be
accessed from the main menu or by pressing the [F1] key on the keyboard. For example:

File Edit Data Wiew Tools ‘Window M Click on
% ‘ rer and then click

Abouk Contents, ..

Climate Anirmals

Skart
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Clicking on BEEZESIEEENN or the [F1] key reveals the following menu.
Click on window topic on which help information is

needed.
E? AWM Help
g 5 B
Hide Back Print  Options
LContents ] Indes ] o
L ccct” Overview of AWM
=] Climate Screen
% Animal Screen
[5] Locations Screen Wh at AWM Does
% Additions Screen
[5] Wash W ater Calculator
5] Flush '/ ater Caloulator AW a1s planning/design tool for anirnal feeding operations that can be used to estinate the production of
=] Ruroff Screen manure, bedding, process water and determine the size of storageftreatment facilities. The procedures and
[=] Maragement Train Screen calculations used in AW are based on the USDA-NRCS Agricultural Waste Management Field Handbook.
a Design Screen
5] Manure Master " " :
5] Edlting Database Tables AW uses the concepts of "Manure Master" to produce a gross nutrient balance but does not track mass or
=] Calculator concentration of nutrients for determining land application rates or for other utilization components.
% Reports
=] AwM Database
o Features of AWM
o Prowvides manure characteristics for eight animal types with the abiity to modify these characteristics and
add animal types as necessary.
o A enraintn Frv baddine srractarrratar Fuch rratar and ather addibane fadhs rrranta cbrasen (O
— — — — —

L Hel .

Help can also be accessed on each screen by clicking on the ﬁ button or pressing the
[F1] key on the keyboard. Help accessed in this manner gives information about the current
screen.

NG~ AWM

Conservation Service

Mew lE:-cisting] Recent |

Landowner: |
Designer: |
Data Source: |MWPS |
Select State: I—Ll
Operating Penod Setup | k.
Chick button above to define or Cancel Click on the

modify the operating period(z]
41—  Hebp

Help button.
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Entering Data into AWM

The following provides general guidance on how to enter data into the input fields used in
AWM screens:

1. Clicking on an input cell within a screen activates the edit mode. The edit mode is
indicated by the cursor blinking at the end of any value or by the text that is already in
the cell.

2. Double clicking on an input cell within a screen activates the edit mode and
highlights the data in the cell so that it can be replaced.

3. Using the arrow keys will exit the edit mode and move the focus rectangle to a new
input cell.

4. Typing any value or text in an input cell that is not in edit mode (cursor is not
blinking and is highlighted with the focus rectangle) replaces whatever data is in the
cell.

5. Pressing [Enter] in an input cell causes the focus rectangle to move to the next input
cell while remaining in the edit mode.

Using the above guidance for entering data into AWM input fields is demonstrated with the
following example of changing the precipitation and evaporation values in the AWM Climate
Screen.

1. Start AWM, select a state and then iress the ﬂ button on the Start screen,

Landowner: |
Designer: | // Select a State.
Data Source: |pr5 =
Select State: OR - Click on the
]
Eﬁ brating Period Setup | k. — button.
Rl pn above to define or Cancel
gg + operating penod(z] =
TH Help
T b —

Page 10 AWM User Guide



2. Click in the January precipitation cell. This action activates the edit mode, and the
cursor will be blinking after the value to be edited: Click on January

Prec input cell.

4 Climate Selection

Select Climate Data Source Optionz for Evaluating Monthly Het Prec - frap
' -
& Lse AwM D atabase If prec-evap < 0 then set net value to 0
o Always zet net value to prec-evap
(" Enter custom climate data for this job
(" lgnore evap value, and uge prec. only
Prec i Ewvap [in]
January 617 048
select County: |0) ACKAMAS | February 439 0.81
. March 3.99 1.57
Select Station: |y wiL L AMETTE EXP STN ORE151 | g
April 2.64 2.39
- ’47 ) May 217 3.74
25 %1 - 24 Hr. S5torm Precipitation: inches June 173 133
Lagoon Loading Rates: July 0.70 5.40
Rational Design Method August 0.34 4.93
Barth KVAL- - September 1.84 3.36
October 311 1.71
huc?:rj; Rate for Odor. - Ibs ¥5/cu. ft/day Movember 6.03 0.76
December .09 043
LRV Max: 0.0106 |he y§/cu. ft/day
Total 40.80 29.91
MRCS Deszign Method
Anaerobic Load Rate: - Ibz ¥5/A1000 cu. ft/day Help | ok |

3. Highlight the value with the cursor and mouse or clear the cell by backspacing and
then type in a new value followed by pressing [Enter]. This exits the edit mode and
moves the focus rectangle to the February precipitation input cell.

4. Pressing [Enter] in step 3 above allows one of two actions to be taken in the February
precipitation input cell:

a.) Type in a new value replacing whatever value is in the cell or,

b.) Press the backspace key to activate the edit mode indicated by the cursor blinking
at the end of the value or text. This allows the value in the cell to be highlighted
with the mouse or use the backspace to delete the data and then type in a new
value.

5. Press [Enter] to go to the next cell.
6. Steps 4 and 5 can be repeated for each cell that requires editing.
See note next page.

AWM User Guide Page 11



Note: An input cell is shaded red when the value in the cell is outside the range of
reasonable values stored in the database. The values stored in the database can be
edited by accessing the Tools -> Options menu. Cells shaded red is just a warning to
the user that the data is outside the normal range and the data will still be used by the
program for calculations.

Although most states’ rainfall and evaporation data are in the database, some information has
not been updated. The Agricultural Waste Management Field Book, Chapter 10 has rainfall
data for the continental United States. It can be downloaded at the NRCS website
(http://www.info.usda.gov/CED/ftp/CED/neh651-ch10.pdf). The database for AWM will be
periodically updated as information is submitted from the states.
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Chapter 4 —Running AWM

Start Screen

Skart

AWM may be started in a number of manners as explained in Chapter 2. When AWM is
opened without a specific design file it will open with the following screen.

Conservation Service

Mew lE:-:isting] Recent |

Landowner: ||
Designer: |
Data Source: |MWPS -l
Select State: I—L|
Operating Perod Setup | OK
Chck button above to define or Cancel

modify the operating period(z]

Help

AWM User Guide Page 13



Start Screen

Skart

The illustration below shows the “New” tab selected. This is also the default setting.

ONRGS

Matural Resources

Conservation Seryigs

Landowner:

Designer:

Data Source:

Select State:

|MWPS €

MWF5
MBCS Maryland

Operating Period Setup |

Chick button above to define or
modify the operating period(s]

ak

Cancel

Help

“New” tab selected.

Type in landowner’s

” name.

Type in your name.

Click here to access
7 the Data Source
drop-down list and
then select the
preferred animal data
source.

Page 14
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Start Screen

Skart

OO0 _A

Conservation Service

Mew lE:-cisting] Fecent |

Landowner:
| Click here to select

- a state.

Desi |
ezigner:

Data Source: |NHE5 j ’/ Operating Period Setup
button if the farm

Select State: OR ~ has more than one

operating period.
Operating Period 5etup ak
Chick button above to define or Cancel
modify the operating period(s] =
Help

Operating Periods

AWM has two options for defining operating periods. The screen shown on the next page

will appear when the T ITE AT 20T button is clicked on. Click on the radio

button  10peratingPerind - for 1 operating period when the facility is operated the entire year
without variation. For example this option would be selected for a dairy where animals are

in confinement for the entire year. Click on the radio button ** 2 Uperating Feriods for 2
operating periods when a facility operates in two distinct periods. An example of when this
option would be selected is for a dairy that keeps its animals in confinement for a part of the
year and pastures the remainder.

AWM User Guide Page 15



Start Screen

: _ “2 Operating
w. Operating Period Periods” are
Mumber of Operating Periods selected.
" 1 0Operating Period & 2 Operating Periods -
Click here to
Select beginning and ending months for the 1zt Operating Period: access the
Beginning Month
Beginning Month: Eoi e dr?ogp-d owgn Iigt and
|January = fie click on the
_ _ _ _ beginning month of
1zt Operating Period: 2nd Operating Period: first operating
|-J-f|r'||.4arj,I -June |-Ju|_l,I - December F period
Click here to

access the Ending
Month drop-down
list and click on the
ending month of
first operating
period.

If “2 Operating Periods” are selected, the beginning and ending \
month for the first operating period must be selected. Once this
period is selected, AWM uses the remaining months for the second
period. The operating period is from the first day of the beginning
month to the last day of the ending month.

Monthly precipitation and runoff for the entire year is used in the
design of waste treatment/storage facilities regardless of the operating period.

To continue work on a previously saved job/design, select either the “Existing” or “Recent”
tab. Selecting the “Recent” tab will show the last ten jobs saved. Selecting the “Existing”
tab will show all the previously saved jobs in a particular directory.
Click on the desired

&
/ file and click the
% button to

Look in: | = ﬂ ~
=Ty ExampleDesign.awm/ load the stored data

=3 Program Files into the AWM program
(Jusda from the selected file.

-5 Mew

ONRCS

Matural Resosrces
Conzervation Service

Select “Existing” tab
for alist of all
previously saved jobs.

/

Mew  Exizting

Filename: | Open {
File Type: [au/M Files [ awm) ~| EEmet) ‘
Help
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Start Screen

Skart
Select “Recent” tab
_ for alist of the last 10
jobs that were loaded

when the user exited

New | Existing | Recert AWM.

File Folder -

: : : — Click on the desired
Exarnple desion. Ae——————ls =t 2 1 0 . .
. = file and click the
mdclazzexample.awm  h:awmsawmcomputerprambdesignfiles

ONRGS

Matural Resources
Conservation Service

awrmnuzermanual awrm b awmawrncomputerprgmi.designfiles Open button to
e nenensengeas [ f| o e stored data
" ' ' PR ! into the AWM program
from the selected file.
4 [
Open ‘
Cancel

Help J
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Climate Screen %

Climate

The climate screen allows the user to define the monthly precipitation and evaporation, the
25 year — 24 hour precipitation, and the anaerobic lagoon volatile solids loading rates. There
are two options for defining the climate data used within AWM. One is to use the AWM
database, which is the default option shown below, and the other is to enter custom climate
data for the job. Any input cell shaded red means the data it contains is outside the range of
values stored in the data validation database. The values in the data validation database
define the range of expected values for an entry as a check for the user. The values in the
data validation database can be edited in the Tools -> Options menu.

# Climate Selection

Select Climate Data Source Optionz for Evaluating Monthly Het Prec - Evap
'y -
& Lse &M Database If prec-evap < O then zet net value to 0
" Alwaps zet net value to prec-evap
" Enter custom climate data for thiz job
" lgnore evap value, and use prec. anly
Prec [in] | Evap [in]
January 617 048
Select County: | ) ACKAMAS | February 4.39 0.81
. March 3.99 1.57
Select Station: |y wWi L AMETTE EXP STN ORE151 | g
April 2 64 2.3
o |47 ) May 217 3.74
29 1. - 24 Hr. Storm Precipitation: inches June 173 133
Lagoon Loading Bates: July 0.70 .40
A ational Dezign Method August 0.34 4.93
Barth KVAL- - September 1.84 3.36
October 311 1.71
Load Rate for Odor. M 1 vs/cu. f/day November 6.03 0.76
December 7.09 0.43
LRV Max: |'1']1 06 |hs VS/cu. ft/day
Total 40.80 29.91
MRBCS Design Method
Anaerobic Load Rate: - Ibs ¥5/1000 cu. ft/day Help | ok |

AWM has three options for accounting for precipitation and evaporation in the design of
waste treatment/storage facilities.

Options for Evaluating Monthly Net Prec - Evap

f* |f prec-evap < O then set net value to 0
(" Abwayz zet net value to prec-evap

(" Ignore evap value, and uge prec. only
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Climate Screen %
Climate

{+ |f prec-evap < 0 then zet net value ta 0

Select this option to consider evaporation only to the extent it does not exceed precipitation.
For the example shown on the previous page, AWM would set precipitation minus
evaporation to 0 inches for the month of July.

f* Alwayz zet net value to prec-evap

Select this option to consider evaporation even when it will cause a deficit value for
precipitation minus evaporation. For the example shown on the previous page, AWM would
set the value of precipitation minus evaporation to —4.7 inches for the month of July.

{# |gnore evap walue, and uze prec. anly

Select this option when evaporation should be ignored. For the example shown on the
previous page, AWM would set the value of precipitation minus evaporation to be 0.7 inches
for the month of July. This may be an appropriate option for waste storage facilities and
anaerobic lagoons where a crust will form that may impede evaporation.

If a state has supplied the data and requested it be provided in AWM, climate data will

populate the screen when the © Use&wh Database gption js selected, based on the County and
Station selected from the drop-down lists. The monthly precipitation, monthly evaporation,
25-year, 24-hour precipitation, and the lagoon loading rate may all be edited by clicking on
the associated input cell for the data to be changed. Changes made in this manner will only
be in effect and saved for the current job. Permanent changes can be made by clicking on
Data > Edit Climate Data on the AWM main menu as shown below. For more on editing,
see Chapter 6, “Modifying the AWM Database.”

Although most states’ rainfall and evaporation data are in the database, some information has
not been updated. The Agricultural Waste Management Field Book, Chapter 10 has rainfall
data for the continental United States. It can be downloaded at the NRCS website
(http://www.info.usda.gov/CED/ftp/CED/neh651-ch10.pdf). The database for AWM will be
periodically updated as information is submitted from the states.
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Climate Screen %

Climate

Click on “Edit Climate Data”

wnl AWM - Untitled
File Edit EeEEN View Tools wighow Help
Edit Climate Data ‘ ‘ ‘ ‘

Edit Animal Data
Edit Bedding Data
Edit Separator Data

255l
Calculator

Start

All of the climate data populating the climate screen is cleared, as shown below, when the

+ Enter custam climate datafor this iab - o5tjon js selected. With this option the user completes all
data fields manually. The data entered in this manner will be saved with the current job and
is not available for future jobs. To have climate data available for future jobs it is necessary
to modify the AWM database. Permanent changes to the climate database can be made by
clicking on Data > Edit Climate Data on the AWM main menu as shown above. For more on
editing, see Chapter 6, “Modifying the AWM Database.”

44 Climate Selection

Select Climate Data Source Options for Evaluating Monthly Het Prec - Evap
 Lse A Database f* |f prec-evap < 0 then zet net value to 0
i Always set net value to prec-evap
{* {Enter custorn clirmate data for this jok
i Ignore evap value, and use prec. only
Prec [in] | Ewap [in]
January 0.00 0.00
Enter County: | February 0.00 0.00
Enter Station: | ez s .
Apnl 0.00 0.00
o - ) May 0.00 0.00
25 %1. - 24 Hr. 5torm Precipitation: inches June 0.00 0.00
Lagoon Loading Rates: July 0.00 0.00
R ational Design Method August 0.00 0.00
Septemb 0.00 0.00
Barth KVAL: - eplembet
October 0.00 0.00
Lood Rate for Odor. M 11 vs/cu. fe/day Novembe: 0.00 0.00
December 0.00 0.00
LBY Max: - Ibs ¥5/cu. it/day
Total 0.00 0.00
MRBCS Design Method
Anaerobic Load Rate: - Ibs ¥5/1000 cu. ft/day Help | ok, |
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Animals Screen =

Animals

The following Animals screen appears when a new design file is being created within AWM
S0 a user can select animal types and descriptions from the data file source selected on start
screen. AWM allows the user to select mixed animal types and descriptions.

3. The animals

2. Click on the animal description in 1. Click on the drop- selected are shown

the choi list window and click whn list t lect ; .
e choices lis dow and clic do .s o selec in the selected list
the add button to select the the animal type. .
. ) 3 window.
highlighted choice. A
Enter quantity and average weight @:1=1[=a 8 V1) 51 efnimal J Delete Selected Row I
_ Animal | Qus e Manure V5 T5
Animal T Dy ] | |
Type Heifer U | cuft/day | |bsiday Ibs/day
Totals | | | |
. <R J
Click the __4d41>> | R XC“CK the " 27"
Addalss button to remove
button to add all e 'Q Co .
animal choices in the << Remore Al highlighted animals
; . ; from the selected list
choices list window. .
window.
i LCancel
Al = Animal Unit
Y5 = Yolatile Solids ﬂ] M
TS5 = Total Solids

. << Remove All
Click the 2| \ Click the _<<Removeal |

button when done button to remove all
: animals from the
selected list window.

In most cases a single value is presented for a specific waste characteristic. This value is
presented as a reasonable value for facility design and equipment selection for situations
where site specific data are not available. However, waste characteristics are subject to wide
variation; both greater and lesser values than those presented can be expected. Typical or
average estimates of “as excreted” manure eventually become out-of-date due to changes in
animal genetics, performance potential, feeding program strategies, and available feeds.
Although these values are useful for long-term planning for utilization of manure and other
wastes, they should not be used in determining a field specific application rate. Site specific
waste sampling, testing, and data collection is essential for the utilization function of an
AWMS.

Growth stage and feed rations are very important in determining manure production
characteristics. For example, once a dairy calf is over 200 pounds and on a hay ration, the
calf’s manure production could be better represented by a heifer’s manure production.
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Animals Screen

mf

Animals

The following screen shows the Animals screen populated with animals selected from the
AWM NRCS data file.

Enter the quantity and average weight
in pounds for each animal selected.

#t" Animals

Animal

Dy
Heifer
Lactating Cow

Totals

AU = Animal Unit
¥5 = Volatile Soli
T5 = Total 5olids

Enter quantity and average weight of gfi

Animals may be added at any
time by clicking on the

Select Animal

Button.

imals Select Animal Mew Animnal Delete Selected Fow J
Animal | Quantity | Weight Manure V5 T5 Manure V5 15
Type | | Ibs | cuft/day/AU | Ibs/day/AU | Ibs/day/AU | cuft/day Ibs/day | Ibs/day
|Daipy | 0 1.30 8.10 9.50 0.00 0.00 0.00
| Dairy 0 1.30 7.77 914 0.00 0.00 0.00
| Dairy 0 1.30 8.50 10.00 0.00 0.00 0.00
' 0| N/ N/A NZA N/A 0.00 0.00 0.00

ds

If another animal type is needed but not shown in the AWM database, click on the

Hew Arirmal

iw. Add Anima

Animal Type:

T otal Solids:

[ < ating Cow

Animal Hame:

Manure ¥Yolume:

Yolatile Solids:

Sludge Accum. Ratio:

|

Flush Water Volume: gal/day

Manure Master Only / 7
Mitrogen: Ibs/

Phoszphorous: lhs/

Potaszium:

bz

Cancel |" ok |I

Page 22

Click the ¢ |

button when done.

| button that will result in the popup screen shown below.

Enter the name of the animal
type being added

Click on the drop-down list to
select the animal type being
added.

Enter the manure volume,
volatile solids, total solids,
sludge accumulation ratio,
and flush water as
appropriate.

Enter the pounds per ton of
Nitrogen, Phosphorous, and
Potassium that will be
generated by the animal being
added after all losses are
accounted for.

Click on this box if animal
type involves lactating cows.
This associates the new
animal with a flush water
volume per animal.
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Animals Screen ter

Animals

A row may be deleted from the Animals screen by selecting the row and clicking on the

Delete Selected Row |
as shown on the screen below.

1. Click on the animal cell to
select the row to be deleted.

Delete Selected Row |

2. Click on the

button or press the [Delete]
key on the keyboard to delete
the selected row.

#¢ Animals
Enter quantity and avefage weight of animals: Select Animal ‘ Mew Animal J Delete Selected Row I
S Animal | Quantity | Weight Manure ¥5 15 Manure ¥5 15
N | I ] | I ] ] I I
Type Ibs cu.ft/dap/Al | Ibs/day/AlU | Ibs/day/AU | cu.ft/day | |bs/day Ibs/day

10 1400 1.30 8.10 9.50 18.20 113.40 133.00

Heifer . Dairy 100 750 1.30 777 9.14 97.50 5B2.75 685.50
Lactating Cow . Dairy 150 1300 1.30 8.50 10.00 25350 1657.50| 13950.00
Totals 260( MN/A N/A N/A NZA 369.20 2353.65| 2768.50

AU = Animal Unit Help oK
¥5 = Volatile Solids

T5 = Total 5olids

The Quantity, Weight, Manure, VS, and TS may be edited by clicking on the input cell and
typing in the desired value as shown on the screen below.

For any of the selected animals, click on
the desired input cell to edit the
displayed data.

it Animals

Enter quantity and average weight of animgfs: El i I Mews Animal Delete Selected Row I

Animal | Quantity T5 Manure ¥5 T5

Animal i
Type 8 apfAU | cuft/day | lbs/day | Ibs/day
Dry | Dairy ' 10| 1400 1.30 8.10 9.50 18.20 113.40 133.00
Heifer | Dairy 100 750 1.30 7T 9.14 97.50 58275 685.50
Lactating Cow . Dairy 150 1300 1.30 8.50 10.00 253.50( 1657.50( 1950.00
Totals - 260 MN/A N/A N/A N/A 369.20( 2353.65( 2768.50

AU = Animal Unit ﬂE'D QK
W5 = Volatile Solids

T5 = Total Solids
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Animals Screen

The values for an animal type appearing on the Animals screen may also be edited by double
clicking on the animal type as shown on the screen below.

o AWM - Untitled

F Data View Tools Window Help

AEH

5

Climate

£ Animals

Enter quantity and average weight

! Animal ||§lu

Animal e
| Twpe
Dry ! Dairy
Heifer i Dairy
| .
Totals | |

Double click on
animal.

AU = Animal Unit
¥5 = Volatile Solids

Animal Name:

Manure Yolume:

Yolatile Solids:

Total Solids:

Sludge Accum. Ratio: !0-0?30

Flush Water Yolume:

~ Manure Master Only

Mitrogen:

Phosphorous:

Potagsium:

iLaclaling Cow
i1 .30
8.50

[10.00 b

cu. ft/dapfAl

11 00.00 gal/day

Calculatar

B rimal | Delete Selected Row |
Manure ! V5 | 15
cuft/day | Ibs/day | Ibsiday
18.20 113.40 133.00
97.50 582 75 685.50
25350 1657.50 1950.00
369.20| 2353.65| 2768.50

I4_3l] lbzfton
|1 -65 lbz/ton
|B_I]4 Ibz/ton

. Revise values in
resulting popup
screen as

necessary,

Help QK

T5 = Total Solids

¥ Lactating Cow

Changes made by editing data within the Animals screen will only apply to the current job
and is not available for future jobs. To have animal data available for future jobs it is
necessary to modify the AWM database. Permanent changes can be made by clicking on
Data > Edit Animal Data on the AWM main menu as shown below. For more on editing, see
Chapter 6, “Modifying the AWM Database”.

w| AWM - Untitled
File  Edit

BEIEN Wiew Tools Window  Help

=S

Edit Climate Data

Edit Bedding Data
Edit Separator Data

Page 24

Runoff IMgmt Train

2

Manurefaster

Calculatar
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Animals Screen rar

Animals

£t Animals
Enter guantity and average weight of animals: Select Animal Mew Animal Delete Selected Row ‘
o Animal | Quantity | Weight Manure w5 T5 Manure V5 T5
] | | | | I I ] | I
Type Ibs cu. ft/dapfAU | Ibs/day/AU | Ibs/day/AU | cu.ft/day | |bs/day Ibs/day

Dry Dairy 10 1400 1.30 8.10 9.50 18.20 113.40 133.00

Heifer Dairy 100 750 1.30 777 914 97.50 582 75 685.50

Lactating Cow - Dairy 150 1300 1.30 8.50 10.00 25350 1657.50( 1950.00

Totals 260 N/A N/A N/A N/A 369.20| 2353.65| 2768.50

AU = Animal Unit
W5 = Volatile 5olids
T5 = Total Solids

Help ax

AWM User Guide

Click the M button when done
editing the Animals Screen.

Page 25



Locations Screen B
LD;ES

The purpose of the Locations screen is to define where the animals deposit their manure
throughout a day for each operating period. It also establishes a manure waste stream from a
location to which waste water, flush water, and bedding are added to form the total waste

stream directed to agricultural waste management system treatment/storage components such

as a waste storage facility or waste treatment lagoon. After typing in the name

Type in the name of a of the location, click the
location where Add Location

animals spend time. | button

or press the [Enter] key.

Locations

Enter Location:

Add Location Delete Selected Row |

Enter the Percent of Manure Fach Amimal Depositz in Each Location:

Location Milker[70lb Milk)
Totals

Hep | Ok |
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Locations Screen

‘ Locations

Once all the locations have been entered, the percent of manure deposited by each animal
type in each location must be entered as shown on the screen below. Please note this is the
percent of manure and not the percent of time. Judgement based on observation will be
required for making this determination because it varies widely. The percent manure must
total 100 percent for each animal type. If two operating periods were selected on the start

screen, a location table will be presented for each operating period.

Locations

Enter Location:
|| Add Location

| Delete Selected Row |

Enter the Percent of Manure F ach Animal Depositz in Fach Lo

Location Milker[70Ib Calf Dry
Milking Parlor 15
Freestall Barn 0 100 &0 60
Paszture 85 40 40
Totals 100 100 100 100
Hep | ok |

3l Enter the percent

of manure each
animal type
deposits in each
location.

To delete a location first select the row by clicking on the narrow cell just to the left of the
location as shown on the screen below. This highlights the row. Now click on the

Delete Selected Rove

period table if more than one operating period was selected on the Start screen.
deletes the location from the table for both operating periods.

)

| Delete Selected HD&A

Enter the Percent of Manure Fach Animal Deposits in

Locations

Enter Location:
| Add Location

70lb Milk] | Calf
b3 | | |

Location
Milking Parlor

Freestg

O armm

azture

Totals

| button. Rows can only be selected and deleted from the first operating

This action

To delete arow,
click here to
highlight the row,
and then click on

Delete Selected Bow |

button or press
the [Delete] key on
the keyboard.

Click the x|

_ button when done
editing the

Locations screen.

AWM User Guide
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Additions Screen ﬂ

The purpose of this screen is to characterize the amount of flush water, wastewater, and
bedding added to the manure waste stream for each of the locations identified on the

Locations screen.

To add additional locations where waste is generated, enter the name of the location and click

Add
on the # button as shown on the screen below.

Type in the name of additional waste
streams. These will appear in the table in

italics after clicking on the

£ Additi,\ns

&dd

button.

Additionalgaste Stream:

Note: Do not add recycled water. That has already been accounted for in the system. Only
add newly introduced water to the system for wash and flush water.

Waste Streams Wash Water | Flush Water Bedding Type Amount Amount

—- Unitz —> gal/day gal/day Ibsfday | cu. it/day
Milking Parlor 0.00(._.. 0.00( ... 0.00 0.00
Freestall Barn 0.00]... 0.00]... 0.00 0.00
Pasture 0.00(._.. 0.00( ... 0.00 0.00
Hotding Area 0.00 ¢ 0.00( ... 0.00 0.00
Hep | oK |

\

The additional waste
stream entered is
shown in italics.

Click on the j button to
access the Wash Water and
Flush Water calculator

The total wash water and flush water in gallons per day may be entered directly or by using

the pop-up calculator. The pop-up calculator screen is selected by pressing the j button
next to the Wash Water or Flush Water input cell as shown on the screen above.

Page 28
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Additions Screen ﬂ

The calculator pop-up screen for wash water follows:

Enter the amount that Type in the washes or
Location that applies to the operation minutes per day for
wash water is in gallons per unit that is each operation where
being calculated appropriate for each an amount was entered
for. Source or Hose. for a Source or Hose.

Wash Water Calculator, for, Milking Parlor

Source Amount Units Washes/Day Total [gal/day]
Bulk Tank - Automatic Wazh gal/wazh
Bulk Tank - Manual Wash gal/waszh
Pipeline in Milk Parlor galfwazh
Pail Milkers galfwaszh
Cow Prep - Automatic gal/wazh/cow/day
Cow Prep - Average gal/waszh/cow/day
Cow Prep - Manual galfwazh/cow/fday
Milk Housze Floor galfday
Parlor Floor [w/o Hush]) gal/day
Other gal/day

Hoszes Amount Units Minutes/Day Total [gal/day]
Hoze 1 galfminute
Hoze 2 gal/minute
Hoze 3 gal/minute
Hosze 4 gal/minute

Wash Water Total »
Help | LCancel | k.
Checking this box means the last _ ok, |
Click the button

data entering into the Wash Water
screen will be saved and displayed
the next time the screen is accessed.

when done editing the
Wash Water screen.
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Additions Screen ﬂ

The calculator pop-up screen for flush water follows:
Enter the amount of

Location that flush flush water used for
water is being each animal in gallons
calculated for. per head(animal).

Flush Water Calculator for Milking Parlor

Animal Quantity | Sug. Flush Yolume luzh Yolume | Daily Fluzh
--- Unitg --» gal/head gal/head gallons
Milker[70lb Milk) 1000 100,00
Calf 100 100.00
Dy 200 100.00
Heifer 300 100.00
Flush Water Total

[v SaveData

Help | Eancel|

Checking this box means the last _ ok,
data entering into the Flush Water Click the 4 button
when done editing the

screen will be saved and displayed
the next time the screen is accessed. Flush Water screen.

Take care to indicate a flush volume for only those animals identified as spending time at the
location on the Locations screen. Also please note that if recycled water is used for flushing,
values entered should only be to the extent that fresh non-recycled water is added to the
system.

Clicking on the ¥ 5&&Data chack box will save the data in the Wash Water and Flush Water
calculator for the current design session of AWM. All values entered into the Wash Water
and Flush Water calculator will be lost once the AWM design session is closed.

Page 30 AWM User Guide



Additions Screen

Additions

The purpose of this screen is to characterize the types and amount of bedding used per day
for each waste stream for each of the locations identified on the Locations screen.

Click the arrow to access
the drop-down list of
bedding types, then scroll

day, if known.

down the list and select

£ Additions

Additional 'Waste Stream:

Note: Do not add recycled water. That has already ®Rgen accounted for
add newly introduced water to the system for wash ahy flush water.

Enter the amount of
bedding in pounds per

If the producer knows the The

amount of bedding used by compacted
volume, rather than by weight, volume of
you can use trial & error to enter bedding that

the weight until the known loose
volume is displayed.

contributes to
the storage
volume is
4| computed
based on the
effective
density of the
bedding.

Rezet Effective Defsities ‘

the system. Only

Waste Streams Wash Water = Flush Water Beddihg Type i} Amount | LY Amt | C¥ Amt
--- Units ---» l gal/day l gal/day l . Dendjty l Ibs/day l cl fh‘;dayl cu ft/d
. Milking Parlor 000 ... 0.00] ... 0.00 0.00 0.00 o0fo
Freestall Barn 0.00]... 0.00] ...| Sawdust / Shavings \ 15.75| 270.00 25.71 17.14
Heifer Bamn 0o .. 0.00] ... ﬂ g.00 0.00 0.00 0.00
Pasture 000 ... 0.00( ... |Honlegume Hay [chopped ~ 0.00 0.00 0.00 0.00
| Holdting Arec 0o0| 000 [eond H ooo] ooo] o000 000
3 | gz;rdust / Shavings ﬂ
Straw - Oats [baled]
e o | o

Click the OK button /
when finished editing
the Additions data.

Bedding Type — Select the bedding type from the drop-down list. The default bedding types
included in AWM are shown below. Additional bedding types may be entered by choosing
“Data / Edit Bedding Data” from the AWM main menu.

AWM User Guide

Composted Digestor Solids
Composted Manure

Com Tops [shredded]
Ground Limeztone

Legume Hay [chopped]
Legume Hay [looze]
Monlegume Hay [chopped]
Honlegume Hay [loose]
Sand

Sawdust / Shavings

Soil

Straw - Oats [baled]

Straw - Wheat [baled)
Straw [baled]

Straw [chopped]

Straw [looze)

Wood Chips

Wood Shavings

Here is the complete
list of Bedding Types
included with the
program by default.
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Additions Screen q

Eff Density -- The volume occupied by bedding in a manure storage facility is reduced to
account for the manure filling the void space in the bedding over time. This is accounted for
by AWM using the “effective bedding density” in the Bedding Data table. Effective density
is affected by management style, such as the amount of time between cleanouts. The default
values can be changed by the user by overwriting the displayed values. Eff Density values
can be reset to the default values in the Bedding Data table by clicking the Reset Effective
Densities button.

Amount -- Click on the input cell for the bedding selected and enter the amount of bedding
added in pounds per day. If bedding is not added every day, the amount used should be
converted to an equivalent pounds per day. If the producer knows the amount of bedding
used by volume rather than by weight, then use the LV Amt field to help you convert volume
to weight. See the example below.

LV Amt -- For reference, the volume (cu ft/day) of loose bedding added is displayed, based
upon the density of the bedding set in Bedding Data table and the amount of bedding added
(Ibs/day).

Use this field to assist in converting bedding amounts known by volume into amounts by
weight. For example, if a producer knows that 6 cords of sawdust/shavings are used per
month, then this will convert to (6 cords x 128 ft*/cord) / 30 days = 25.6 ft* per day. Then,
using trial and error, enter amounts of bedding by weight until the known volume is
displayed in the LV Amt column (a value of 270 Ib/day is equivalent to 25.7 ft*/day).

CV Amt -- For reference, the volume (cu ft/day) of compacted bedding is displayed, based
upon the effective density of the bedding set in Bedding Data table and the amount of
bedding added (lbs/day). The compacted volume is the amount of bedding that will be used
by AWM to size the receiving facility.

The loose and effective densities of bedding can be modified by accessing the “Data / Edit
Bedding Data” from the AWM main menu. For more on editing the AWM databases, see
Chapter 6, “Modifying the AWM Databases”.

2N Yiew Tools Window Help

il AWM - h:lengineeringlawm programisample.awm
Edt Clmte Data A

Ed: Animal Data n q 't’
!

Start mrs Locations | Additians Caloulgtor | ManureMaster
it Separator Data
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Runoff Screen ﬁ

R unoff

The Runoff screen estimates the contaminated runoff that must be managed by the waste
management system. Runoff volumes estimated by AWM are conservative overestimates.
Because of this, the user is encouraged to use a method outside the program to determine the
monthly and the 25-year, 24-hour runoff volumes, especially when larger watersheds are
involved.

AWM computes runoff for two types of “watersheds:”
= impervious “watersheds” such as roofs and frequently scraped concrete slabs; and
= pervious watersheds including feedlots with a manure pack..

The runoff volume from only one drainage area for each type of watershed is computed. If a
system design requires evaluation of more than one drainage area in one or both types of
watersheds, the runoff volumes will need to be computed outside the program and entered as
demonstrated below.

Impervious watershed runoff is computed based on a Curve Number of 98 and a user input
impervious area in square feet. AWM does not allow the Curve Number for this watershed
type to be changed. If a different Curve Number is desired, the AWM computation should be
made using the pervious watershed category or by using a method outside the program.

Pervious watershed runoff is computed on the basis of a user-input Curve Number and
watershed area in acres. Feedlots having a manure pack should use this method. The user

can enter a 1 day curve number and click the * (1-day) radio button and the program will
convert the 1 day curve entered to a 30 day curve number. The 30 day curve number
computed from the 1 day curve number may be viewed by passing the mouse pointer over
the * (1-day) radio button. If the user enters a 30 day curve number and clicks on the
(30-day) radio button, the program will use the curve number as entered to compute the
runoff volumes.

AWM computes runoff by first converting the 1-day Curve Number to a 30-day Curve
Number using the following equation:

CN3p = CN; — (CN; — ((CN172.365)/631.79) - 15) log 30

The equations of the EFH Handbook Chapter 2 revised for a 30 day CN would be:
S =(1000/ CN3) — 10 (Rearranged Equation 2-4)

Q=((P-0.25)"2/ (P + 0.89)) (Equation 2-3)

Where:  Q = runoff in inches
P = rainfall in inches
S = potential maximum retention after runoff begins in inches
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The following illustrates the Runoff screen when  Calculate Monthly Runoff Yolumes (i

button is selected. Type in the pervious
Click on the ™ Calculate Monthly Runoff ¥olumes watershed area and the 1-
radio button. day runoff curve number for

the 25Yr-24Hr storm rainfall
and the 1-day or 30-day
// runoff curve number.

ﬁ Runoff
Methods for defermining monthly runoff volumes: Runoff ¥Yolumes (1000 cu. #)
1.] Calculate wgfurmes fram climate and watershed data. Pervious = Impervious | Monthly Totals
2.1 Enter runfff valumes directly in the table on the right. Jymfafy 0.00 0.00 0.00
ghfliary 0.00 0.00 0.00
Rungtf Yolume Method #ch 0.00 0.00 0.00
Al 0.00 0.00 0.00
i Calculate Monthly Runcff ¥olumes
ay 0.00 0.00 0.00
i~ Enter Monthly Runoff Yolumes June 0.00 000 0.00
July 0.00 0.00 0.00
B Auguszt 0.00 0.00 0.00
Pervious Waterzhed Area: afres
September 0.00 0.00 0.00
Pervious Curve Humber [1-day] a0 October 0.00 0.00 0.00
for 25-%1 24-Hr Storm Runoff:
HNovember 000 000 0.00
Pervious Curve Mumber @+ [4-day]
for Monthly Runoff: ) a0 December 0.00 0.00 0.00
Total 0.00 0.00 0.00
Impervious Area [roofs. slalfs. etc): sq. ft.
25 Y 1-%4 Hr S5torm Runoff: 0.00 0.00 | 0.00
WARNIMNG: The volumed computed by the program afyconservative over-estimates. The user 1z Help
encouraged to uze a mgthod outzide of the program to Ngmpute runoff volumes for larger
watersheds and where precision iz vital. Methods for comguting monthly runoff yolumes include the oK.
MEH-4 stream gauge gfocedure and SPAW =
If a one day curve number is \ Enter the impervious
selected, passing the mouse watershed area.

over the * (1-day) will display

the 30 day curve number.
The program will compute the runoff volumes based on the precipitation data and runoff
curve numbers entered on the Climate screen.
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R unoff

Runoff volumes based on calculations made outside the program may be entered directly into
the runoff table. To enter runoff volumes directly, select the * Enter Monthly Runoff Yolumes
button as shown below.

Click on the f* Enter Monthly Bunoff ¥olumes Enter monthly runoff as

determined by a method

radio button. outside AWM.
Methods for determining monthly runoff volumes: Runoff Yolumes (1 Cu.
1.] Calculate valumes figfn climate and watershed data. Pervious pervious onthly Totals
2] Enter runoff valugfes directly in the table on the right. January 0.00 0.00 0.00
February 0.00 0.00 0.00
Runoff ¥giime Method March 0.00 0.00 0.00
April 0.00 0.00 0.00
Iculate Monthly RBunoff Yolumes
May 0.00 0.00 0.00
Enter Monthly Runcff ¥olumes June 0.00 000 0.00
July 0.00 0.00 0.00
Auguszt 0.00 0.00 0.00
September 0.00 0.00 0.00
October 0.00 0.00 0.00
Hovember 0.00 0.00 0.00
December 0.00 0.00 0.00
Total 0.00 0.00 0.00
25 Yr-24 Hr Storm Runofi: — 0.00 | e
WARNIMNG: The volumes computed by the program are conservative I 5. The user iz Help
encouraged to uze a method outzide of the program to compute runoff volum
watersheds and where precizion is vital. Methods for computing m off volumes include the oK.
MEH-4 stream gauge procedure and SPAW. F
/

Enter 25-year, 24-hour storm
volume as determined by a
method outside AWM

Click the M

button when done
editing the Runoff
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Mgk Train

The purpose of the Management Train screen is to define the sequence of management
components, as described within AWM, for each waste stream developed by the program in
the Locations and Additions screens. The sequence of components is described in AWM as
management “steps.” AWM is capable of evaluating up to three management steps or
components for each waste stream. Solid-liquid separator components split a waste stream
into two waste streams — solids and liquids. Each of these new waste streams must be
followed by appropriate storage components. An uncovered stacking facility requires a
liquid storage component, either a pond or a tank, be specified in the next step to store runoff.
An anaerobic lagoon with external storage requires that a liquid storage component, either a
pond or a tank, be specified in the next step. Multiple waste streams may be directed to a
single management component

The following is a blank Management Train screen for a dairy as it would appear when
AWM is run for a new waste management system design. The waste stream column lists the
waste streams from (1) locations defined on the Locations screen, (2) any user-defined waste
streams, and (3) runoff. Clicking on an input cell will access a drop-down list of available
components as illustrated on the screen below.

Click within the input cell to Click on desired component for
access the drop-down list of Step 1 of the waste stream
available components. management stream.

- Management Train

‘Waszte Stream Step 1 Step 2 Step 3
|
Milking Parlor Mone (Cyfar)
Solid-lfuid Separator 3

Mew Storage Pond

Mew Storage Tank,

Mew Dry Stack (Uncovered)
Pasture Mew Dry Stack (Covered)
Mew Anaerobic Lagoon

Mew Anaerobic Lagoon (Ext)

Freestall Barn

Holding Area

Component Yolumes [cu. ft/day]

Component Hame Manure Wash Water Flush Water Bedding Total Waszte Volume

A storage pond, storage tank, covered dry stack, or anaerobic lagoon can be a terminal
component in the waste management train. However, a solid-liquid separator, uncovered dry
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Mamk Train

stack, and anaerobic lagoon with external storage all require an appropriate subsequent liquid
storage component.

The first time the component drop-down list is accessed, all of the available components will
be identified as “new”. Once a component is selected for a management step, it will appear
on subsequent drop-down lists and is available for use in other waste stream management
steps. For example, if “New Storage Pond” is selected for one management step, the next
time the drop-down list is accessed this pond will appear as “Storage Pond #1”. This pond
could then be selected for another waste stream. However, if a second storage pond is
desired, “New Storage Pond” would be selected. Subsequent access to drop-down list would
identify this pond as “Storage Pond #2.”

When the “Solid-Liquid Separator” component is selected, another drop-down list is
accessed that gives a list of separator types.

Select solid-liquid Select type of
separator. separator.

i Management Train

Waste Stream Step 3

Milking Parlor

Mone {Clear) ]
Solid-Liquid Separatar Decanter Cegfrifuge 16-30 gpr
Mew Storage Pond >

Mew Storage Tank, Settling ghsi
Pasture Mew Dry Stack (Uncovered) Skatic Jiclined Screen
Mew Dry Stack (Covered) Static Inclined Screen 12 Mesh
Mew Anaerobic Lagoon Static Inclined Screen 36 Mesh
Mew fnaerobic Lagoon (Ext) vibrating Screen

‘ibrating Screen 16 Mesh
vibrating Screen 18 Mesh
Vibrating Screen 24 Mesh
Vibrating Screen 30 Mesh

Freestall Barn

Holding Area

Component Yolumes [cu. ft/day]

Component Hame M anure Waszh Wwater Flush Water Bedding Total Waszte Yolume

Help ak
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The next step after solid-liquid separation must define the components to which both the
solids and liquids will be directed as shown below.

Clicking in the input cell for Step 2, for the example
shown below, accesses the drop-down list of
components that can be selected as a treatment/storage
component for both liquids and solids.

- Management Train

Waste Stream Step 1 Step 3

o Solid-Liquid Separator ---Liquids---»
Milking Parlor

Static Inclined Screen 12 Mesh - Solids-—>» Mone (Clear)

Freestall Bain Mew Storage Tank
Mew Dry Stack (Uncovered)
Mew Dry Stack (Covered)
Mew Anaerobic Lagoon

Mew fnaerobic Lagoon (Ext)
Holding Area |

Pasture

When an uncovered dry stack is selected, an appropriate liquid storage component must be
selected in the next step to store its runoff as shown on the screen below.

Clicking in the input cell for Step 3, for the example shown below,
accesses a drop-down list of components that can be selected to
store runoff from the uncovered dry stack’s facility. \

o Management Train

Waste Stream Step 1 Step 2
i Solid-Liquid Separator ---Liquidz---> | Storage Pond #1
Milking Parlor . .
Static Inchned Screen 12 Mesh - Solidz—> | Dy Stack [Uncovered] i1

Mone (Clear)

Freestall Barn \ Mew Storage Pond
Mew Storage Tank
Mew Anaerobic Lagoon

Pasture

Sk Pond #1

Holding Area

Component Yolumes [cu. [t/day]

Component Hame Manure Wash Water Flush Water Bedding Total Waste Yolume
Storage Pond #1 329.70 73.52 0.00 0.00 403.22
Dry Stack [Uncovered) #1 26.68 0.00 0.00 0.00 26.68

When an anaerobic lagoon with external storage is selected in the management train, it must
be followed in the next step with an external storage component as illustrated below:
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Clicking in the input cell for Step 3, in the example shown

on the screen below, accesses a drop-down list of storage
components that can be selected to store effluent from the
anaerobic lagoon.

s Management Train

Waste Stream Step 1 Step Step 3
Milking Parl Solid-Liquid Separator ‘ —Liquids—> bic: Lagoon [Ext] #1 — )'
ilking Parlor i i ) ore (Clear
Static Inclined Screen 12 Mesh --Solids-—-> | Dy Stac vered] #1 | Stora New Storage Pond

\

Mew Sk Tank
Freestall Barn eve Storage Tanl

otorage Pond #1

Pasture

Holding Area

Component Yolumes [cu. ft/day]

Component Hame Manure Wash Water Flush Water Bedding Total wWaste Yolume

Diy Stack [Uncovered] #1 2668 0.00 0.00 0.00 26.68
Anaerobic Lagoon [Ext) #1 MN/A MN/A MN/A N/A MN/A
Storage Pond #1 o0.00 0.00 0.00 0.00 0.00

Help | ok
ClicktheM

button when done
editing the
Management Train

Component Volumes (cu. ft/day) - the relative volumes of materials stored within the
different structures. The solids portion of manure removed by the use of a solids separator is
not subtracted from the solids storage volume of a storage pond or lagoon. Therefore, the size
of the lagoon or storage pond is NOT reduced due to the use of a solids separator.
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Design

The Design screen will reveal tabs for each of the storage or treatment facility components,
except solid-liquid separation facilities, that were selected on the Management Train screen

as shown below.

Click on a Tab for the component to
access the design screen.

a Design Wast .Storage Struc.ures

Iput Dirmension:

Bottom Length ~

Battarn Lenagth 40.0 ft
Freeboard: 1.0 ft

Jan - Dec  Botw xL:8.0x 4000

Input Data Crosz Section
Critic:al Manthsz:
Facility Options
Storage Depth 7.0 ft

[ Set'wall Height

Storage Pond #1 Dy Stack (Uncovered] #1 ] Anaerobic Lagoon #1 | Dy Stack [Covered) #1 ] Storage Tank #1

Top'w wl.: 8.0 4006

|

D=80H
-
] W=80ftH
" Defing Storage Period \.4’/
le—— L-s00nr —™
‘Water Budget (1000 cu ft)
Jan Feb Mar Apr May Jun Jul Aug Sep Oct Moy Dec Total
Withdrawal Dates | [] O O O O O O O O O O
‘Waste 019 018 019 018 019 018 019 019 018 019 018 n1s 223
Cum. Storage Vol 019 037 055 074 043 11 1.30 1.49 1.67 1.86 204 223
Hep | oK |
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Dry Stack Design Screen (Covered and Uncovered)

The AWM design of dry stacks is the same for both uncovered and covered stacks with the
exception that the precipitation falling on an uncovered dry stack is directed to an anaerobic
lagoon, waste storage pond or tank. Therefore, from a sizing standpoint, both covered and
uncovered design screens are the same. Even though the design screen for a covered dry
stack is illustrated, it applies to uncovered as well.

Option 1. Simple four-sided stacking structure

Enter the storage depth & Click the drop-down arrow AWM will compute the
bottom dimension to to select Bottom Width or structure dimensions based
accomodate the site and Bottom Length on which on all the inputs.

available standard drawings. to base the design.

Ja Design Was'e Storage Structures

Dryp Stack [Covere

Cross Section
Critical Months: May - Oct  BotwaL: 30023271

Input Data
Topwal:300x327 0

Facility Options -

Starage Depth i Setw'all Height

Input Dimension:

Battom Width 30 it Unchecked for simple design

Freeboard: 0.5 ft T /

D=6.0ft
Max. Storage Yolume Method ok
(s iDiefine Withdrawal Manths W =300 ft it
Define Starage Period V

|"‘7 L=327h —."I\{/

‘Water|Budget (1000 cu ft)

Jan Feb Mar Apr May Jun Jul Aug Sep Oct Moy Dec Total
Withdrawal Dates O O O O O O O O O O
Waste 09 0.85 091 0. o 0.aa 09 091 D.SS/" 0.51 0.88 091 1073

I,
Cum. Stprage Yol 2.70 50 445 b33 \D.Eﬁ 1.73 2.70 3.60 4}!@ 5.33 n.as 1T

\| ol
\

\ N / Hep | ok |

Option to define the withdrawal
months is selected for this
example.

Check the boxes for those months when
withdraw will occur. Note: AWM assumes
that the structure is empty at the end of the
selected months.
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To design a dry stack facility the following entries are needed on the dry stack design screen
in AWM:

Storage Depth — Click on the input cell and enter the value for the preferred depth in feet
(not including freeboard) for the dry stack facility.

Input Dimension — Click on the drop-down list box and select the dimension, bottom width
or bottom length, on which to base the dry stack design.

Bottom Width, Length — Click on the input cell and enter the value in feet for the dimension
selected to base the design on, bottom width or bottom length.

Freeboard — Click on the input cell and enter the value for the preferred freeboard in feet for
the dry stack facility. NRCS does not require a minimum freeboard value for dry stack
facilities but regulatory agencies may require a minimum freeboard value.

Max. Storage Volume Method — To select the way AWM computes the maximum storage

volume needed in the dry stack facility click on the * radio button associated with the
preferred method.

For the ™ Define Withdiawal Months - method the user needs to click on the check boxes associated
with the months when the dry stack facility will be emptied. When a withdrawal month is
checked, AWM assumes the dry stack facility will be empty at the end of the months
selected.

For the ™ Define Storage Period —— method the user needs to select the number of months from
the drop-down list or input the number of months of storage preferred. For a dry stack
facility design AWM determines which month or group of consecutive months during the
year for the storage period specified requires the greatest storage volume and sizes the
facility accordingly. The critical months for design are displayed in the cross section area of
the design screen. To design for less than 1 month of storage select 1" for the months of
storage and another drop-down list will appear where you may select the number of days of
storage.

AWM will compute the required dimensions of the facility based on the entered values.

Note: The dimensions at the top of the screen will also include the computed top width and
top length of the stack. If the combination of side slope, stack height and bottom length or
width causes the top width or length to become negative, the program will display the
following message in the status bar:
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Crozs Section
Crtical Manths:  [Mar-Mar] BotwxL: 300x 928 TopWxL: zn.
If a combination of height, width, length and side

slope generates a negative Top dimension, then this
error message will appear at the bottom of the screen.
Modify the dimensions to eliminate the error.

If this warning message is displayed, modify the input values depth (D), sideslope (2),
bottom width (W) or length (L) to properly size the facility and eliminate the warning
message.

Option 2 — Setting the Wall Height for a Dry Stack Facility

AWM provides an option on the design screen to set the wall height and stack height for a

dry stack facility. The following inputs are needed when the ¥ 2et%alHeight check box is
selected on the design screen for a dry stack facility:

Wall Height — Click on the input cell and enter the value for the preferred wall height for the
dry stack facility. Note that if zero is entered for the wall height the program assumes a slab
is being sized for a dry stack facility.

Storage Depth — Enter the depth that the material will be stacked. This value may be higher
than the wall height.

Input Dimension — Click on the drop-down list box and select the dimension, bottom width
or bottom length, on which to base the dry stack design.

Bottom Width, Length — Click on the input cell and enter the value in feet for the dimension
selected to base the design on, bottom width or bottom length.

Freeboard — Enter the value for the preferred freeboard in feet. Note that this dimension
will set the assumed maximum height that the material will be stacked against the walls. In
the example shown above, the assumed depth of material will be stacked 3.5 feet against the
walls and 6 feet total in the center.

Note the difference in the definition of freeboard between options 1 and 2. In option 1, the
freeboard is added to the storage depth to compute the total wall height. In option 2, the wall
height is set by the user, so the freeboard determines the height that the material is stacked
against the wall.

Side Slope - Click on the input cell and enter the value for the assumed slope of the stacked

material within the facility. The side slope entered is considered to be uniform on all four
sides of the stack.
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Design
Enter the wall height, storage Click the drop-down arrow AWM will compute the
depth and bottom dimension. to select Bottom Width or structure dimeisions

Bottom Length on which to
base the design.

based on all inputs.

Ja Design Waste Storage Structures

Dy Stack [Oovered) #1 ]

Input Data Crozs Section
“wiall Height Critical Maonths: Mar-Aug BotWxL:250x457 R Top'w x L 15.0% 28.7 ft
-Facilitpy Dplions
Storage Depth

Check the box to activate this option screen

[w Set'wall Height

Input Dimension: Bottom Width

Bottom Wwidth 25 i

Enter the freeboard

and slope of the
Freeboard: -5 A stacked material.
Sideslope R atio: 2

Max. Storage Yolume Method
" Defing Withdrawal bonths

(¢ Define Starage Period
Stokage Period: monthz
|-17 W =250H

Water\Budget (1000 cu ft)
Jan | Feb Mar Apr May | Jun Jul Aug Sep | Oct Nov Dec Total

Waste 091 0.85 0.9 0.89 0.91 0.ga 0.9 0.91 0.8 09 0.88 0a1| 1073
Storage|\Volume | 0.9 0.85 0.91 0.83 0:91 0.83 0.9 0.91 0.8 0.9 0.8 0.91

o ol
\
\ Hep | oK
\
Option to define the storage
period selected for this

example (6 months).

Max. Storage Volume Method - To select the way AWM computes the maximum storage

volume needed in the dry stack facility click on the * radio button associated with the
preferred method.

For the ™ Define Withdrawal Months - method the user needs to click on the check boxes associated
with the months when the dry stack facility will be emptied. When a withdrawal month is
checked, AWM assumes the dry stack facility will be empty at the end of the months
selected. To design for less than 1 month of storage, select all the months and another drop-
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down list will appear where you may select the number of days of storage, as shown above in
Option 1.

For the ™ Define Storage Period - method the user needs to select the number of months from
the drop-down list or input the number of months of storage preferred. For a dry stack
facility design AWM determines which month or group of consecutive months during the
year for the storage period specified requires the greatest storage volume and sizes the
facility accordingly. The critical months for design are displayed in the cross section area of
the design screen. To design for less than 1 month of storage select 1" for the months of
storage and another drop-down list will appear where you may select the number of days of
storage, as shown above in Option 1.

Max. Storage Yolume Method :
~ Define Withdrawal Maonths To design for less than one month of storage,

select a 1 month storage period, then enter the
number of days of storage. This example will
Storage Perind: 1 - | rmont design the stacking facility for 21 days.

o Define Storage Period

1 days

AWM will compute the required dimensions of the facility based on the entered values.

Note: The dimensions at the top of the screen will also include the computed top width and
top length of the stack. If the combination of side slope, stack height and bottom length or
width causes the top width or length to become negative, the program will display the
following message in the status bar:

Crozs Sechion
Citical Manths:  Mar-Mar! BotwxL: 300x 926 TopW xL: zn.
If a combination of height, width, length and side

slope generates a negative Top dimension, then this
error message will appear at the bottom of the screen.
Modify the dimensions to eliminate the error.

If this warning message is displayed, modify the input values depth (D), sideslope (Z),
bottom width (W) or length (L) to properly size the facility and eliminate the warning
message.
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Option 3 — Pad Design

You can size a pad to stack material by checking the box for “Set Wall Height”, then entering
zero for the wall height.

Enter the depth of storage, the bottom width or length, and the assumed side slope of the
stacked material. Then, define the storage volume method and enter the length of storage as
described above in option 1. An example of a pad design is shown in the following figure.

Enter a wall height
of zero to design a
stacking pad.

1 Design Waste Storagr: Structures

Dry Stack [Covered) # l

Input Data Cross Section
wall Height ‘ Critical Months: May - Dct  Bot'WwWxL: 40024951 TopWwxL:240x3351

1 Facility Oplions
Storage Depth f v Set'wall Height Check the box to activate this option screen.
Input Dirmension: Bottom Width -

Battam Width 40 ft

Sideslope R atio: 2

Method

L=495H

B \I.:l)eflne Storage Period

‘Water Budget [1000 cu ft]

Jan | Feb [ Mar Apr | May | Jun Jul Aug | S5ep | Oct | Hov Dec | Total
WithdawalDates . [0 | O | O olo ol ol o o | o
Waste 041 0.85 0491 0.8 051 0.88 0.91 0.91 0.88 0.91 0.8 091 1073
Cum. Storage Yol 270 355 445 533 09 1.79 2.70 360 448 539 0.8s 1.79

« | I
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Storage Pond Design

The design of storage ponds in AWM allows the user to define a rectangular or circle type
pond. AWM bases the design on the storage depth, bottom width or length, permanent
additional storage, freeboard, sideslope ratio and maximum storage volume method inputs
made by the user.

The following screen illustrates a rectangular storage pond design based on defining
withdrawal months:

Vary depth and
bottom length to
accommodate the

Ja Design 'Waste Storage Structures

Click on drop-down
list to select the
shape of the pond to
base design on.

Click on drop-down list to
Bottom Width | .

select
|Buttum Length j dimension
to base design on.

Storage PN #1 l
Input Data Cross Sectig
Shape: Rectangle Critical Mopfiz: Oct-Apr  BotwxL:1500%211.1 1 Top'w wl: 2100 % 2711 it
gffity Dptions 1‘
10.0 !
Total Depth f Include Sail Liner [~ Include Ramp
|put Dimension: Bottom Width
Battam Width 1500 fe————— TL=271.1HR |
Permanent &dd'|  |p et T Freeboard = 1.0 ft ’_
Elonc ' \ Depth of 25 Vr. 24 Hr. Storm Event = 4 i\
\ 25 Yr. 24 Hr. Storm Event Runoff= 11770 * ft 0.26 it
. . 3
Sideslope Ratio: \ Depth of Precipitation - Evaporation = 25.2?\ /
D=10.0 it
Volume of Manure, bedding, wash water,
Mazx. Storage Yolume Method flush water, nommal runoff, and extemal - 22102 CF 477 it
@& Define \Withdrawal Manths storage (if any) 1
Define Storage Period
Pamanent Additional Storage = 0 CF 0.000R
le—— BL-2111R
WaterBudget (1000 cu ft)
Jan Feb Mar Apr May Jun Jul Aug Sep 1] Tdeal
Withdrgwal Dates  [] O O | O O O O O v
Waste 32200 3073 7.ES ?.R 7.B9 744 7.B9 ?.ES’ 744 769 NB 32.& 15445
Runolf 14.94 a9 VB4 3E9 \2.49 152 [IRR i} 178 493 144 181 \ a7
Prec-Eva 2756) 73] 1332 3w N 726 1597 Afis|  aze|  ses| 2583) IO\
Cum. Stordge Vol 25001 30698 330E2| /074 FAN \ 8.8 063 /EI.DU 5.91 2.1 9281 1?5)\ \
‘ \ / Stage Storage Cuve | Help | e |

o Define Withdrawal Months
selected for the example

shown.
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For a storage pond design is based on a storage period or withdrawal months, AWM
determines which set of consecutive months during the year requires the greatest storage
volume and sizes the facility using the user’s decision on Total Depth of the structure.

The following screen illustrates a circular storage pond design based on defining a storage
period:

Vary depth to Click on drop-down list to
accommodate select shape of the pond to
the site. base the design on.

Ja Design \Vaste Storage Structures

Storage Porlgd

Cross Section
Critical Months: Oct - Mar  BotDia: 1757 ft Top Dia.: 2357 ft

Input Data

Shape:
Facility Dptions
10.0
e el I [ Include Sail Liner
fe————— Top Dia = 235.
Permanent 4dd1  [g o ft T Freeboard = 1.0Nft ’_
ST ' \ Depth of 25 Yr. 24 Hr. Storm Event =\4 in \ /
\ 25 Yr. 24 Hr. Storm Event Runoff = 1'\?0 cu. ft 0.32 l‘ !
. . 3
sideslope Fiatio: \ Depth of Precipitation - Evaporation = 2\]2 in \ /
D=10.0 it
Volume of Manure, bedding, wash water, 10173 CF
Max. Storage Yolume Method 2:'5" m}";’r’ :;rrml unoff, and external - = 691 ft
¢ Define Withdrawal Manths o 1

[efine Storage Period

\ Permanent Additional Storage = 0 CF \ / 0.00 ft
manths —_— ‘

|#€——— BotDia=175.7 it

Stofgge Period:

Water Rudget [1000 cu ft)

Jan Feb Apr May Jun Jul Aug Sep Oct Hov Dec Total
Waste 3220 013 B9 744 769 T.44 769 769 T.44 ?.89\31.18 3220 18645
Runoff 14.94 8.91 T 369 249 1.52 o1 029 1.75 493 \add \18.19 7897
Prec-Evap' 2112 13.74 10.21 206 -2.35 BBEl 1223 1007 -2.81 BE3 19 &.BU ‘
Storage Yolme 6326 h2.78 25.54 NS 7.e3 3.40 0.00 0.00 E.ED 19.29 85.45\ ?WD ‘

\ \ Stage Storage Curve | Help ok |
+ Define Storage Period o ptjon Click on drop-down list AWM computed
selected for the example to access a list of dimensions for
shown months(1-12) to select a the example
storaae period from. shown.

Storage depth is the Total Depth of the pond, as selected by the user, less freeboard, depth of
25-yr., 24-hr. precipitation, depth of 25-yr., 24-hr. storm event runoff, and depth of
precipitation less evaporation option selected on the Climate screen. Permanent additional
Storage may be required to meet management goals or regulatory requirements (see NRCS
Practice Standard 313, Waste Storage Facility).
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The following screen illustrates the soil liner design option for a storage pond:

Click on Enter the permeability of the soil Enter the allowable specific
W Include Soil Liner {0 to be used for the liner. This discharge. This value may
access the soil value is normally available from be based on regulatory
liner design the soil mechanics report. requirements.

screen. \ \

B

Storage Pond #1 ]

Cross Section
Critizal Months: Oct- M Bot'Ww o« L 1500x 19701 Top'fxl: 2100« 2570

Input Data

Shape: Rectangle

Tatal Depth 10.0 ft
|nput Dimension: i Bottom Width v || h‘
Bottom Width 1500 fe—"

d=(k*H)/ (v-
Permanent Addl g
Storage: Cirat
Allowable Specific [p 1042

= Calculator E] |E|E
Discharae [v]:

‘ U:G200003 D Liquid Depth (H): |7-3 ft

Facility Options
w Include Soil Liner ™ Include Ramp

Permeability [k): It per day

cu ft per gquare [t per d

Calculated Liner [g 7
2 ‘ 8 I a ‘ ; I c Depth (d): R

Liner Depth: 1.0 It
4 ‘ 5 8 Ee If the calculated liner depth iz less than th

minimum liner depth, the minimum value

1.0f be used. The minimum liner depth can
1 2 3 : i - changed on the Dptions screen. Cancsl J oK I
1} + =
Mar Apr May Jun Jul Aug s Oct Mov Dec Total

769 744 7.E9 744 T.E9 7ES 744 7E9| B 3220 18645
764 269 249 152 011 0.29’ 1.75 4593 14.44| 1819 FRLT
1266 383 282 679 1802 -1%8 303 823 2456 3044
Ta: |Feeh’Day j 2793 1496 7.35 217 0.0 /D.DD E16[ 2090 7016| 8083

Convert “'\ / .
—] / Stage Storage Curve | Help | ]9 |
el EE g
oooo
25a0

Click on to access the conversion
calculator. The calculator can be
used to convert centimeters per
second to feet per day. See the
Calculator section in this chapter for
more information.

The liquid depth AWM uses for designing the soil liner is based on the total depth of the
pond less freeboard, depth of 25-yr., 24-hr. precipitation, and the depth of the 25-yr., 24-hr.
storm event runoff. NOTE: this will increase the total depth shown on the schismatic.
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The following screen illustrates the parallel ramp design option for a storage pond:

Click on the drop-down list to Enter the preferred Click on
select the type of ramp to slope ratio and W Include Ramp g
design. Choices are Parallel width of the ramp. access the ramp

design screen.

[

and Perpendicular. \

[

SR r_ﬁg"'-w..a-:-.ﬂ.-_:-.-.:v;-.sw.-.a_cm;aﬂ.‘-. -

Storage Pond #1
Input Data Cross Section
Shape: Rectangle Critical Months: Top'w' L 2100 % 257 .01t
Total Depth e f
|mput Di 10t :
Bottarm
Permang
Sh | =
arage " RI=55.0 TL=2595 1 _
Sideslop Width 15 t ""‘--_______
Length 99.0 ft TSw=1940 Blestdhed Tw=210.0
Max. 5 BSW=13 BLwW=150.0
(" Def§ — Facility Dimensions
 Def | [Rw = Ramp Width ‘
RL = Ramp Length
Storage R5 = Ramp Slope Ratio
D = Final Depth =
BL = Bottom Length \
L BW = Bottom Width
Water B| | |TL = Top Length I L Y RL=99.0 Lotk |
TW = Top Width \ L e
BLW = Bottom Long Width RS D=10.0
Waste | |BSW = Bottom Short Width ssao o ——4 e 5,
5 = Facility Side Slope BL=199.5
Runoft TSW = Top Short Width \ :
Prec-Ev
Storage = = =
All dimensions are in feet. Cancel ‘ oK |
\ Stage Storage Curve | Help | ok |
AWM computes the length of

the ramp and shows the
dimensions of the ramp on
the schematic drawing of the
storage pond.

Note: The parallel ramp design screen is not available for circular ponds.
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The following screen illustrates the perpendicular ramp design option for a storage pond:

Click on the drop-down list to Enter the preferred Click on
select the type of ramp to slope ratio and W Include Ramp g
design. Choices are Parallel width of the ramp. access the ramp

and Perpendicular. \ /

/ X

Storage Pond #1 ]

Input Data Cross Section
Shape: Rectangle Critical Months: DcfMar  Bot'w xL: 0w 157.0f Top'w' L 2100 % 257 .01t
Facility Dptions
100 ]
Tatal Depth ft ¥ Include Soil ] Edit W Anclude Rarnp
Input Dimension. | Rottam Width =1\

. Ramp Design for Storage | 'ond #1

Bott
et Ramp Dimensions
F'elmanf RW=15.0
Storagef | Ramp Type =
Ramp Slope Ratio 3 ‘
Sideslop Width 15 f RL=99.
Length 99 0 ft \
Max. 5{
(" Def§ — Facility Dimensions BWw=150.0 TwW=210.0
& D=fl | |RW = Ramp Width BL=191.1
RL = Ramp Length
Storage RS = Ramp Slope Ratio
O =Final Depth TL=251.1
BL = Bottom Length
- BW = Bottom Width
Water Bf | |TL =Top Length L=33.0 I Tw=210.0 i
1SW =:0I3Iitmygt'hl 3| S m—— h=1k
= Fagil ide Slope =
Waste ! 5 .
Runoff
Prec-Ev
Storage
2 All dimensions are in feet. Cancel ‘ oK |
Stage Storage Curve | Help | ok |

AWM computes the length of
the ramp and shows the
dimensions of the ramp on
the schematic drawing of the
storage pond.

Note: The perpendicular ramp design screen is not available for circular ponds.
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Ja Design Waste Storage Structures

Storage Pond #1 l

Input Data
Shape:
Total Depth

|hput Dimension:

Bottorm Width

Permanent Add
Storage:

Hectangle -

0o

Bottom Width ~

1500

—
—

cu. ft

=

Design

Cross Section
Critic:al Manths: Oct - Mar  Botw xL: 150019704

Facility Options

Top'w w L. 2100 % 257.0 1t

v Include Soil Liner Edit W Include Ramp E dit

fe————— TL=257.0ft

T Freeboard = 1.0 ft

—

Depth of 25 Yr. 24 Hr. Storm Event = 4 in

25 Yr. 24 Hr. Storm Event Runoff= 11770 cu. ft 0.27 it
Sideslope Ratio: Depth of Precipitation - Evaporation = 25.02 in
D=10.0F
Volume of Manure, bedding, wash water, - 210173 CF y
Max. Storage Yolume Method 7;“5“ m‘t;r, normal nunoff, and extermal - = 583 It
" Defing “Withdrawal Months orage (if any) 3
(» Define Storage Period
Permanent Additional Storage= 0 CF 0.00 it
Storage Period: [ | months
101 #N—k\ Bi = 197.0 it =Y
Water Budget (1000 cu ft)
Jan Feb Mar Apr May Jun Jul Aug Sep Oct Mov Dec Total
‘Waste 32200 3013 7.E9 744 7.B9 744 7.B9 7.B9 744 VB9 3B 3220 18645
Runolf 14.94 a9 T.E4 3E9 249 152 a1 029 1.75 498 1444 1813 TAIY
Prec-Evap 2613 1702 12EE 383 282 74| 1B02| 1236 2303 8.23| 24BE| 3044
Storage Yolume V328| BROS| 2799 1496 735 217 ] ] 16| 20490| 7OiE| 8083
tage Storage Curve | Help | ok |

Click on
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Stage Storage Curve | button to
access the stage storage curve for
the storage pond design.
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The following screen illustrates the stage-storage curve for the example storage pond design:

=¥ Stape Storage Curve

Storage Pond #1

Aa+006

3 56+006 l//
36+006 b /

= 25e+006 S

il . /
P -

&) N

o 2e+006 Sasc s

£ / .

= M

o q"ﬁ.‘

> 1.5e+006 =

1e+006 / = ~—
“h“.
/ g

500000 - -

1 2 3 4 5 §; 7 ] 9 10
Depth {ft)

== /0lume Stored === ‘Yolume Remaining

A stage-storage curve defines the relationship between the depth of liquid and the storage
volume available within a structure.

Volume Stored: measured from the bottom of the structure, how much liquid has been stored
or how much more liquid can be stored.

Volume Remaining: measured from the top of the structure, how much liquid remains after
pumping, or how much liquid can be pumped.
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Storage Tank Design

The design of tanks in AWM allows the user to define a rectangular or circular type tank.
AWM bases the design on the storage depth, bottom width or length, permanent additional
storage, freeboard, precipitation excluded or not and maximum storage volume method
inputs made by the user.

The following screen illustrates a rectangular tank design based on defining withdrawal
months:

Click on drop- Click on drop-down list to select
Click on the dolvvn ”Sr;[ to f |Buttum Width j or |Buttum Length j
Tark Covered: | check select shape o dimension to base design on.

the tank to base
the design on.

box if tank is covered to

R Vary depth and width as needed
exclude precipitation.

to fit tank to site conditions
and/or standard drawing.

X

<= Desi in Waste Storage Structures

Storage\l ank #1

Botiw v L 40.0 = 45.4 ft

Top'w wL.: 4000 % 454 1t
1;
[ Include Ramp

Input Dimensick: Bottom Width

Bottom Width 40.0

Permanent Add
Storage:

-

Tank Covered:
D= 6.0t

Max. Storage Yolume Method

(a Defing Wwithdrawal M onths W =AR 0¥
“\Define Storage Period ]
__F“'— L=454f —m
Water Bulget (1000 cu Ft)
Jan Feb Mar Apr May Jun Jul Aug Sep Oct Mov ec otal
Withdrawal Rates O O O O O O O O O
Waste 03| ors| os3 0.85\ nga| oen| os3| oss| o 06N, o080] \az| s
Prec-Evap 087 o085 03] oo7 \@9 033 084 054 /5_18 024 \381 N\
Cum. Storage V. SHE S R HIEEI AR ]
\ N\ // Help \ o |
) ) 4
* Define Withdrawal Manths Click on box to check or AWM computed
option selected for the uncheck months when dimensions for
example shown. withdrawal is planned. the example
Withdrawal is on the last shown.
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For a tank design based on a storage period, AWM determines which set of consecutive
months during the year for the storage period specified requires the greatest storage volume
and sizes the facility accordingly.

The following screen illustrates a circular tank design based on defining a storage period and
excluding precipitation:

Click on Tark Covered: v Vary depth to

if tank is covered with a af:commqqate the
lid or roof to exclude site conditions.
precipitation.

Click on drop-down list to
select shape of the tank to
base the design on.

Ja Design Waste Storage f tructures

Storage Tank #1 l

Input Data Pfozz Section
Critical Months: Mar - Aug BotDia: 2391 TopDia.: 2391
Shape:
Facility Dptions
Total Depth - ft
Pemmanent &dd1 (o go i
Shorane: t

Tank Covered: v D=12.0 1t

Max. S5torage Yolume Method
" Defing Withdrawal Maonths
+ Define Storage Period

StoNgge Period: [ | months

Water BRdget [1000 cu ft)

Jan Feb ar Apr May otal
Waste na3 0.7a 3 0.a0 0.8 0.a0 0.a3 0.8 0.a0 043 D.EEI\ 0.83 979
Storage Volyne 0.a3 0.7a D.B}\ 0.a0 0.8 0.80 083 0.8 0.80 043 0.80 \ 83

\ N\ P \ TS
\ \
f¢ Define Storage Period Click on drop-down list Dimensions
option selected for to access a list of computed by
the example shown. months(1-12) to select a AWM for the
storage period. example shown.

Storage depth for covered tanks excludes depth of 25-yr., 24-hr. precipitation and depth of
precipitation less evaporation option selected on the Climate screen. Permanent additional
Storage may be required to meet management goals or regulatory requirements (see NRCS
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Design

Fermanent Add'
Practice Standard 313, Waste Storage Facility). Passing the mouse pointer over Storage:

will generate a popup box that shows the cubic feet of storage associated with the depth of
additional storage entered.

The following screen illustrates the parallel ramp design option for a rectangular tank:

Click on the drop-down list to Enter the preferred Click on
select the type of ramp to slope ratio and ¥ Include Ramp to
design. Choices are Parallel width of the ramp. access the ramp

and Perpendicular. \ design screen.

B e

s ’ﬁﬁ‘?-.’ﬂ?\-éi

Storage Tank #1 ]

Input Data Crozs Section
Shape: Rectangle Ciitical Months: M _fAug - j Topw xL:24.0%293H
Facility Options
Total Depth 8.0 ft

|nput Dimengion;

Bottam

Permane
Storage:

Ramp Slope Ratio
Tank Coy | yrigmh
Length
Max. 54
" Defil - Facility Dimensions
e ;
Lef RW = Ramip Wiilth
RL =Ramp Length
Storage f RS = Ramp Slope Ratio =)

D = Final Depth
| TL =Top Lendgth
Afaterpy || [0S Topmickh Bl i p—T47 3 |

Tpe
Waste I THS:S___—_-____P— I 1 Bid

Storage

All dimensions are in feet. Cancel ‘ Ok J

AWM computes the length of
the ramp and shows the
dimensions of the ramp on
the schematic drawing of the
rectangular tank.

The parallel ramp design screen is not available for circular tanks.
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The following screen illustrates the perpendicular ramp design option for a rectangular tank:

Click on the drop-down list to Click on

select the type of ramp to Enter the_ preferred v Include Ramp ¢q
design. Choices are Parallel slppe ratio and access the ramp
and Perpendicular width of the ramp.

design screen.

w AWM - c:\documents and settings\charle) Zuller\my documents\awm current\example.awr

it [ats Yiew Tools Window Help

S m\ 8 S| e i

Climate Animals Locations Additions Funoff IMgmt Train Design r | MafireMaster
Desie A
Storage Pond #1 | Diy Stack [UnRovered) 11 I Storage Tank #1 JAnaerobigfl agoon #1 i
 Input Data Cross Seclion
S Rectangle [Clilical Months: /eb = [% Bt 'w « P500.0 2 B98.7 1t Top'w xL. 5400 % 7387 f |
Facility Dptigfis -
10,0 - Pempendicular ramp adds 11200 cu. ft.
Total Depth I ft L—- Include ﬁ"ﬂ W Include Flame Bt | of e et
Input Dimey i
Ramp Design fo orage Pond
Bottomn W
attom ~Ramp Di
Pemmanen| ‘ / RwW=12.0
Storage: Ramp Type [fepiiurmm / 1 '
Al Ramp Slope Ratio |9 /
Sideslope o RL=90.
Width 112 ft
Length 90.0 Ft
A
~Max. 5id |
@ Defind - Facility Di i BW-=500.0 TW=540.0
i Defing | [pW = Ramp Wicith =698.7
RL = Ramp Length
RS =PRamp Slope Ratio l
D = Final Depth PrL=-738.7
BL = Bottom Length
BW = Bottom Width
Water Bud | |TL =Top Length RL=3p.0 I Tw=540.0 |
TW = Top Width —— ZD=10.0
————| | |s =Facility Side S} RS
Withdram 2R SIODE S
Waste
Runoff |
Prec-Eva| - - -
s . | | All dimensions are in feet. Cancel | oK
R
y A
I Stame Storaos Curve | Helo | ok | |
| Press 1 for Help on Any Scieen | B/28/2007 11:00 &AM

AWM computes the length of
the ramp and shows the
dimensions of the ramp on
the schematic drawing of the
rectangular tank.

The perpendicular ramp design screen is not available for circular tanks.
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Design

Anaerobic Lagoon Design

The inputs for the design of anaerobic lagoons in AWM are very similar to the design of a
storage pond. AWM allows the user to define a rectangular or circular type lagoon. AWM
bases the design on the storage depth, bottom width or length, permanent additional storage,
freeboard, sideslope ratio, sludge accumulation period and maximum storage volume method
inputs made by the user.

The following screen illustrates a rectangular anaerobic lagoon design based on defining
withdrawal months:  Click on drop-down
list to select the -(;-2; NrI]?CS
shape of the lagoon metr?odolo i
to base design on. 9y
used unless the

Click on drop-down
list to select
Bottom Width |

Vary depth and

bottom width to Choices are |Buttum Length j i .

- - ¥ Uze Rational Design Method
accommodate rectangular and dimension to base is checked
the site. circular. design on. '

12 Design Was ‘e Storage Structures

Anaerobic Lag ‘
Input Data
Critig I Famths: Oct- Apr  Bot'w =L 20002063 R wl.: 28605 2623 1t
Shape: 4‘
Pacility Options
Total Depth B [ehek el L [~ Use Rational Daign Method
Input Dimension:
Botomwidh 2000 fe———————— TL=26231 -]
Pemanent 2441 [ Freeboard = NO ft {
Storage; cu. f _¢_ =
\ Depth of 25 Vr. 24 Hr. Storm Everf 4 in /
Freeboard: 1.0 ft \ 2
: 25 Yr. 24 Hr. Storm Event Runoff = \cu. ft 0.00 ft
D ejth of Precipitation - Evaporation = \25_27 i
Sideslope Ratio: 2 \ v n j
Volume of Mamure, bedding, wash wat
E'l:ridog; Ascun. L EER D=14.0 ft g?;gm:}l?’;;o}mnl runeff, and extermal \= 104783 CF ‘1_81 ft
Max. Storage Yolume Method
(¢ Define Withdrawal Months MEnimum Treatment Volume= 0 CF l] 00 ft
[efine Storage Period
Sludge Ace. & Permu Addl Storage = 407351 [;\ T 841
le——— BL=2063H
dget (1000 cu Ft)
Jan Feb Mar Apr May Jun Jul Aug Sep Oct Mow Dec [ otal
O|o|0o O|lo oo O \NO
18.25) 1427 1525 14.K 18.25) 1476 1525 15.25( 0 1476 153\ 14.76 \15.25 80.05
2240) 0ss| 1537  41s[\ooo| oo oo o 000] 882) \pa7| X77
17087 20B11| 23673 Z5REV ‘N& 30.m 45 26 .51 ¥R2T| 2808 YO 123\2
Stage Storage Curve | Help 0K |

i+ Define Withdrawal Months
selected for the example
shown.

Page 58

Click on box to check or
uncheck months when
withdrawal is planned.
Withdrawal is on the last
day of the month checked.

AWM computed
dimensions for
the example
shown.
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For an anaerobic lagoon design based on a storage period, AWM determines which set of
consecutive months during the year for the storage period specified requires the greatest
storage volume and sizes the facility accordingly.

The following screen illustrates a circular anaerobic lagoon design based on defining a

storage period and using the Rational Design Method: The NRCS
Click on drop-down list to design
select shape of the lagoon methodology is

Vary depth to
accommodate
the site.

used unless the
¥ Uze Rational Design Method
is checked.

to base the design on.
Choices are Rectangular
and Circular.

J= Design \Vaste Storage Structures

Cross Section
Critical Monthz:

Input Data

Oct - Mar  BotDia: 200071 Topia.: 2560

Shape:
Facility Options
14.0
Total Depth ft [~ Inchude Sail Liner W Use Ratignal Design Method
|.47 Top Dia = 256.0 ft
E'ntaonr'::r:nt addl g it _{ Freeboard = 1_k[t f
\ Depth of 25 Vr. 24 Hr. Storm Evert -\ 4 in /
Freeboard: 1.0 ft \ 25 Vr. 24 Hr. Storm Evert Runoff= OWeu. it 0.00 ft I
Sideslape Ratio 2 \ D eyth of Precipitation - Evaporation = ¥ 02 in !
) Volume of Mamure, bedding, wash water,
Sludge Accum. 5 _ flush water, normal runoff, and extemal 90025 CF
Peniod: SHEEIS D=14.01t storage (if any) ‘1-39 ft
Max. Storage Yolume Method
" Define Withdrawal Months \ Minimum Treatment Volume = 0 CF \ / 0.00 ft
f« Defing Starage Period )

\Slutlge Ace. & Permy Addl Storage = 407351 [:R / r 1857 it

|#———Bot Dia = 200.0 ft

Apr May Jun Jul Aug Sep Oct Moy Dec Total
Waste 1476| 15.25| 1476 1525 1525 1476 25 147 \ 15,254 180.08
Prec-Evap 2484 1609 11.$\ 323 0.00 0.00 0.00 0.00 0.00 F’K 2329 \28.95
Storage Yolu 4003|3035 2705 \?.99 1525 14.76| 15.25| 1525 1476| 2280 &8.05 \4.20

\‘ \‘ Stage Storage Curve | HEIN [
& Define Storage Period Click on drop-down list AWM computed
option selected for the to act(r:]esi ?zllstt of et ?hlmensmnls for
example shown. months(1-12) to select a e example
storage period. shown.

Permanent additional Storage may be required to meet management goals or regulatory
requirements (see NRCS Practice Standard 359, Waste Treatment Lagoon). At least 1 year
of sludge accumulation period should be entered to account for sludge buildup in the lagoon.
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The following screen illustrates the soil liner design option for an anaerobic lagoon:

Click on Enter the permeability of the soil Enter the allowable specific
v Include Sail Liner to be used for the liner. This discharge. This value may
to access the value is normally available from be based on regulatory

soil liner design the soil mechanics report. requirements.

screen. N\ \ /

Anaerobic Lagoon #1 |

Cross Section
Critical Months; Oct - Mar EBEot'w s L1987 « 20001 Top'w « L 54,1 » 206.0 ft

Input Data

Rectangle

Shape:
Facility Options

14.0
Tatal Depth ft v Include Soil Lines
Input Dimenzion; Bottom Length ~

[v Usze Fifitional Design Method

BottarLength 2000 fe———— TL = 256.0 ft
R - _¢_ Freehoard = 1.0 ft
Depth of 25 Yr. 24\r. StomEvernt= 4in I
25 ¥r. 24 Hr. Stom Nvent Runoff = Dcu it .00 Rt
Depth of Precipimtim\- Evaporation= 25.02 i|l
Volume of Manwre, bedgling, wash water,
5 % a ; c | pson — =
e’
4 5 & CE
1 3 3 o Permeability (k]
1.0t Allowable 5 pecific
q 2 Discharge l:"l: 0.028 cu ft per square [
- +
Liquid Depth (H): |12-4 it
Type: ]
HE ]\r"elomty Flow ﬂ 2K i Calculated Liner g 4 f
2 ] J 1476| 1525 Depth [d): t
1OM: | Centimeters Asecond -
4.09 0.00 Liner Depth: 2
To 12.85 1525
5 IFEEtHDa-'f' ﬂ If the calculated liner depM is less than the
minimum liner depth. th
& t be used. The minigpd
S \ changed on the Cancel | ak |

~

Stage Storage Curve ] Help J 0K |

Click on |28 to access the conversion
calculator. The calculator can be
used to convert centimeters per
second to feet per day. See the
Calculator section in this chapter for
more information.

The liquid depth AWM uses for designing the soil liner is based on the total depth of the
lagoon less freeboard, depth of 25-yr., 24-hr. precipitation, and the depth of the 25-yr., 24-hr.
storm event runoff. NOTE: this will increase the total depth shown on the schismatic.
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Ja Design Waste Storage Structures

Anaerobic Lagoon #1 l

Input Data

Shape:

Battarn Length 200.0

Permanent Add'
Storage:

1]
Freeboard: 1.0
2

Sidezlope Fatio:
Sludge Accum. [
Period:

(" Define Withdrawal Months
+ Define Storage Period

Storage Penod: b -

‘Water Budget (1000 cu Ft)

Max. Storage Yolume Method

Cross Section

Rectangle - Critical Months: Oct - Mar  BEot'wxL.: 1381 x 200014 Top* =L 2547 x 256.0 1t

Facility Options

14.0

Total Depth ft ml lelhuele Sl Ltney v Uze Rational Design Methad
Iput Dirmension: Bottom Length -

ft hi TL =256.0 ft —--i
_¢_ Frechoard= 1.0 It
Degth of 25 Yr. 24 Hr. StoomEvert = 4 in
fe 25 Yr. 24 Hr. Storm EventRunoff = O cu. ft 0.00 ft
Depth of Precipitation - Evaporation= 25.02 in

cu. ft

Volume of Manwre, bedkling, wash water,
flush water, normal nnoff, and extemal = 90025 CF

years D=15.0 ft storage (if any) 1.60 it
Minimum Treatment Volume = 0 CF 0.00 ft
3
Shilge Ace. & Perm Addl Storage = 407351 CF }\Z\W’B_ 68 It

months
yromr FRie BL = 200.0 ft =

Feb Mar Apr May Jun Jul Aug Sep Oct Moy Dec Total
1427 1825 1478|1525 1475|1825 1828 1478|1825 1476| 1525| 180.05

2033 1491 409 0.0a 0.00 0.00 0.00 0.00 354| 2943 3653

Jan
Waste 15.25
Prec-Evap .39
Storage Yolume 4664

34E0) 3018|1885 1525 1476| 1525 1525 1476 2479 4419] 5184

Stage Storage Curve | Help | Ok |

AWM User Guide

Click on

Stage Starage Curve |
button to access
the stage storage
curve for the
anaerobic lagoon
design.
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The following screen illustrates the stage-storage curve for the example anaerobic lagoon
design:

=¥ Stage Storage Curve =]
Anaerobic Lagoon #1
500000
500000
400000
T
=
e
o 300000
E
=
o
=
200000
100000
0
0 2 4 3] 3 10 12
Depth (ft)
== Yolume Stored === Yolume Remaining

A stage-storage curve defines the relationship between the depth of liquid and the storage
volume available within a structure.

Volume Stored: measured from the bottom of the structure, how much liquid has been stored
or how much more liquid can be stored.

Volume Remaining: measured from the top of the structure, how much liquid remains after
pumping, or how much liquid can be pumped.
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Anaerobic Lagoon with External Storage

The anaerobic lagoon with external storage design option utilizes an anaerobic lagoon to
contain the minimum treatment volume. All other volume requirements are contained in the
storage facility that must follow the lagoon in the management train. The only time this

lagoon would be emptied would be for sludge removal.

The following screen illustrates a rectangular anaerobic lagoon with external storage design:

Click on drop-down
list to select the

shape of the lagoon list to select

Click on drop-down

Vary depth and
bottom width to

to base design on.

|Bottom Width  ~|

base

accommodate Choices are |Bottom Length ~|
the site. rectangular and dimension to
circular.

design on.

J= Design Was, : Storage Structures

Anaerobic Lag

Input Data Cyfzz Section

Rectangle Botw L. 2500 % 2961.7 ft

100

Shape:

Facility Options

Top

w L. 2940 5 3005.7 ft
y

The NRCS design
methodology is
used unless the

[ Lze Rational Desgign Method

is checked.

Starage Depth [ Include Sail Liner [ Use Rational DEsign Method
|nput Dimernsion; Bottom Width -
Batomwidh 2900 g je———  TL-30057 —
3 \ f
I Freeboard= 1 g
Freeboard: 1.0 ft ]
. . 2
Sideslope Ratio:
1AEsIops hiala Mininwm Treatment Volume = 90575 CF 81 R
Sludge Accum. D=11.0 it
Period: . 1k years
\ Slukdge Accurlation = 407351 [ZF\ / 55 ft
‘_
}‘7 BL = 2961.7 It
Help | ok |

Enter the number of years for sludge
accumulation. At least 1 year of sludge
accumulation period should be entered to

account for sludge buildup in the lagoon.
AWM User Guide

AWM computed
dimensions for
the example

shown.
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The following screen illustrates a circular anaerobic lagoon with external storage design

based on using the Rational Design Method: _ The NRCS design
Click on drop-down list to methodology is

select shape of the pond to used unless the

Vary depth to base the dESIQn on. [v Usze Rational Dezsign Method

accommodate Ch0|c_es are Rectangular is checked.
the site. and Circular.

a Design/\Vaste Storage Structures

Anaerobic L\ygoon [Ext] #1
Input Data Crosz Section
Critic-al Months: Bot Dia: 30851 Toglia.: 35251
Shape:
Facility Options
10.0
Storage Depth f [ Include Seil Liner W Use Ha%nal Diesign Method
i-'l— TopDia\3b25f —— —D-i
3 /
I Freehoard= 1
Freeboard: 1.0 ft 1
. . 2
Siesiops Ratio: Minimum Treatment Volume | 408212 CF 455 ft
Sludge Accum. [ D=11.0 It
Period: e
L
Sludge Accunulation = 407351CF 510 ft
X
l«—— R0t Dia = 3085 1t
I Hep | k|
Enter the number of years for
y AWM computed

sludge accumulation. At least 1
year of sludge accumulation period
should be entered to account for
sludge buildup in the lagoon.

dimensions for
the example
shown.

Storage depth is the total depth of the lagoon less freeboard. Since lagoons with external
storage do not provide storage, an additional storage component must follow this type of
facility in the management train.
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Design Screen

=

De=sign

The following screen illustrates the soil liner design option for an anaerobic lagoon with

external storage:
Click on
[v Include Soil Liner

to access the
soil liner design

\

Enter the permeability of the soil
to be used for the liner. This
value is normally available from
the soil mechanics report.

Enter the allowable specific
discharge. This value may
be based on regulatory
requirements.

/

screen. \

| P S T |

/

[x]|

Anaerobic Lagoon [Ext)

Input Data Cross Section
Shape: Critical Months:
Facility Options
S S Include Soil Liner

| & Calculator

Bot Dia.: 3085 ft

Top Dia: 3J25 1

v Uze Bational Design Method

Top Dia=3525 1
0.0000003 T ard= 101t
7 8 9 4 C
MEnimwm Ty it Volume = 408272 CF 4 55 It
4 5 E CE
% e J‘-_.:-__Jt*'-&'} =T l
1 2 3 s F :
d=(k*H}/{v Xk
u : * = Permeability (k] -00085 ft per day
Type: f Allowable Specific g p28
E |Ve|ou:|t_l,l Flaw ﬂ Discharqe [vl: 7 cu [t per square ft per d
From: |Eentimeters!second ﬂ Liquid Depth [H): 7 fit
To |Feet.fDay x g:‘l;:tuhl?:;;:j Liner l0.3 ft
Convert ‘ Liner Depth: 1.0 ft
If the calculated liner depth iz leg#fthan the

minimum liner depth, the mini value will

be uzed. The minimum linegMepth can be

changed on the Options pffeen Cancel | QK |

V4
\ / Help | OK |

~| |l 7
Click on =8 to access the conversion
calculator. The calculator can be

used to convert centimeters per
second to feet per day. See the
Calculator section in this chapter for
more information.

The liquid depth AWM uses for designing the soil liner is based on the total depth of the

lagoon less freeboard.

AWM User Guide
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Conversion Calculator

Calculakar

The Conversion Calculator is available within all screens in AWM and is activated by
clicking on the Calculator button on the AWM tool bar or selecting the Unit Conversion
Calculator from the Tools drop-down menu. The calculator can be used to perform
mathematical calculations but is provided primarily for unit conversion. Select the To and
From units in the combo boxes, type in the number to be converted and press the Convert

button.

The following screen illustrates how the Calculator can be used to convert units:

iw. Calculator

27
7 g 9 ¢ C
4 5 E CE
1 i 3 +
1] ) + =
pd
Tupe: | Al - /
Fram: |.-'1'-.|:re [acre] -
To |5quare faat [f™2) - | <
Correert “\

/

Page 66

Enter the value of the unit to
convert. This example is
converting 2 Acres to Square
Feet.

Click on the drop-down list for
unit type to select the type of unit
to convert. Areais selected for
this example.

Click on the “From:” drop-down
list to select the unit to convert
from. Acre is selected for this
example.

Click on the “To:” drop-down list
to select the unit to convert to.
Square foot is selected for this
example.

Click on the Convert button to
perform the conversion.
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Conversion Calculator

Calculakar

The following screen illustrates the results of the conversion of 2 acres to square feet:

=, Calculator The calculator displays the value
__ in square feet of the conversion
of 2 acres shown in the previous
screen.

The numeric keys on the
calculator can be clicked on to
perform mathematical
calculations. The numeric keys

used for this purpose as well.

Tope: | rea =

From: | acre (acre] =

Tee |5 quare foot (2] =~
Corwvert

The data used in the conversion
calculator can be edited by
selecting Tools->Options from
the main menu in AWM.

syl AWM - h:\awmlawmcom » .erprgmidesigr’des\awmusermanual. awm
File Edit Data  Wiew Bl

Window  Help

Unit Conwersion
Cptions ﬁ

Ruroff

o
T
000,00

MMgmk Train

Design Calculator

ManureMaster
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Conversion Calculator

Calculakar

I Options

General] MumnberChecks Calculator <|1-—

|

Calculator -
Uit Type - Unit Mame Edit Unit Conversion D ata 1/
. LnitConversion '
Factor: nazE1274
Linith ame: |Square pard [yd™2)
it T ype: |.-“-‘-.rea
UzeThis: v =
4 | 4 |Record: 1 Y
Add Tk | Close |
] 4 | Cancel | Apply |

Click on the Calculator
tab and the

E dit Lnit Conversion Data

button to edit existing
conversion data or add
additional conversion
data.

If the UzeThis: ]

box is checked the unit
conversion factor will be
available for use in the
calculator.

Click on the s |

button to add additional
conversion factors.

The user should have a good understanding of the data format before attempting to edit or
add data to the Conversion Calculator database.
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Manure Master is a simple screening tool that can help assess the relative potential for the
nutrients contained in the animal manure from an animal feeding operation to meet the crop
uptake and utilization requirements for those crops that receive applications of manure.
Manure Master calculates a balance between the nitrogen, phosphorus, and potassium
content in the manure and the quantity of these nutrients used by crops. This balance can be
calculated based upon recommended fertilizer application rates, when known or upon
estimated plant nutrient content, when recommended fertilizer application rates are not
known. For nitrogen, the balance is calculated taking into account expected losses from
leaching, denitrification, and volatilization. Manure Master is not a nutrient management
planning tool, therefore criteria in the NRCS Practice Standard 590, Nutrient Management,
should be referenced when developing nutrient management plans.

The following screens illustrate the use of Manure Master:

Click on the . Click on the
Click on the _ _
Beszet Help Wigw the Output [Mutrient B alance]
button to clear ——button button to view nutrient
the input table. to view help. balance.

= Manu e Master Enter the acres of each
Reset Help “Wiews the Output [Mutrient B alance)] "E CrOp that manure and
waste water is applied

Enter the number of acres for each crop you intend to apply | Soil Test or Other Cr
manure oh and the expected vield. For the crops where Recommendgbjae® It available
manure iz to be applied, specify whether or not it iz

Crop Mame Acres Yield Yield Unit
Applied Goal

Manure |g P205 K20 on.

B"’"Zﬁ'e'f..'.f’%f e B - Enter the target yield
sans. By 4 Tons o — goal for each crop in
Bentgrass for Seed Cwt g1 the units indicated next

Bluegrass for Seed cwt to the Yield Goal
Bluegrass Tome E\‘ column.
Hay/Pasture
puckmest Brom ushets | O ~ Click on the O check
Bé‘ﬁ'éi"ﬁi{.;ﬁ?&" Tons - K&%\ box to indicate manure
anola Tons O ™~ and waste water are
Gom for Grain Tons o N\ incorporated into the
Corn for Grain, Tons O A\ soil when applied.
Corn for Silage Toms O \\ Leave blank if manure
Cornfor il 4 W00 200 .. O \\ _and waste water is not
— — O \ incorporated.
Fotten Bales o If available, enter
Fescue Hay/Pasture Tons O ;
recommended nitrogen,
Grass Hay Tons O phosphorous, and
Grass Legume 40.00 6.00| g O potassium application

Hay/Pasture

rates in pounds per
acre.
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The following screen illustrates output from Manure Master based on the previous screen:

Nutrient Utilization

Thiz report is to help evaluate the amourt of nutrients your farm wwould produce
compared to the amount of nutrients it could wtilize based on the crops listed on the next
page that are part of your crop management system.

The factors used to calculate manure nutrient cortent are developed from estimates
that accourt for nuirient losses due to collection, storage, treatment and handling.
When manure is not incorporated, an additional nitrogen loss iz taken for volatilization.

According to the 2 computer program you have the following annual notrient

balance:
Amount Applied | Amount Kilized Balance
Hutrient [Pourds] [Paurds] [Pourds]
Fltrogen — M 2 Ead KTl 11,407 | pounds needed
Phiosphate — F20s a.a0r 3,871 4 505 | pounds of emcess
Potash — K20 16871 10,401 B 470 pounds of emces=s

Mate: Increase or decrease the number of animals or acres of cropland intended far
manure application if you wish to adiust the nutrient balance bazed on N, P2Ds, or
b=

If ywour balance for phosphorus exceeds the amount wtilized by the crops grown, you
may be accumulating phosphorus inthe zoil. Phosphorus iz knowen to contribute to
weater quality problems. As the amount of available phosphorus in the zoil increazes,
the potertial for it to move by the processes of erosion, runoff, o leaching increase.
The Phozphorus Index may be used to determine the relative risk for phosphorus to
became awater quality problem on your farm.

There are many assumptions that were uzed to create this report that make it too
general to use for detailed nutrient management planning . This report iz intended to be
uzed as a decision support soreening tool to allow you to make a quick evaluation as to
whether the quantity of nuirierts applied exceeds the quantity of nutrients wtilized by the
crops grown an your farm. When nutrients applied exceed the nutrients Wilized,
potential increases for nutrierts ta leach or runoff from fields and become pollutants of
ground and surface waters.

Since thiz report iz general in nature, do not assume you have met the total nutrient
requirements of your crop management system, even when the nutriert content in the
manure exceads the nutrient wilization of the crops grosn. You are strongly
encouraged to seek the services of a professional nutrient management specialist to
determine actual applications rates of nitrogen, phozphorus and potaszium to meet the
needs of the crops grosn inyour crop management system.

Contact Matural Resources Conzervation Service, Cooperative Extenszion ar Soil and
Water Conzervation District staff at youwr local USDA Service Center for sasistance in
addre=zing guestions you may have related to manure and nutrient management on
WOUEF farm.
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The following screen illustrates options for Manure Master output:

i a a ompuierprg [es51g 25 \d = d dl. d a e aster Outp L]

B3 File Edit Data Yiew Tooks ‘Windmw Help =&
v N
% ?}!. | ‘l-’

Start Climate Animals Locations Additions Runoff Mgmt Train Design Calculator | ManureMastgr

E=port to Rich Text Format Zoom: I VI Page: I'I "I Help

Nutrient Utilizatio

This reped |15 b Fedp evaugle e
Ptk ool ullze bared on be
rkem.

T dachors usedl localoulak manme roklen] conkrNge develops] Fom esimalkes hal zooun 47 ruklen
I 725 e bocdiechay, shorage, keaknent and bl marwre |5 nolinc poraled, anadd bond
rivcgen lces b laken ¥1vdalizalon.

e s : Export ta Rich Test Farmat
Hutlent Amgunt Sppled | Amount iz Ealanes
fPeund & iPaund e und i

Mircgen - ] 132414 e BT Msoracesu

Plroople - PO 121540 TOS0 [ 114510 DDl.IN&CE”
Polath - [ 2T 1oe | 2o pou'dso\'w

Mok: creare of degeans Fe rumber of aimals of a0 er of aopland Irkraed 57 marme applcakon
w3l [ rublen| bEave bxsd on L PO o kD,

Hyour balarve 17 pheaplons enged s be avound ullzsd by he Top s grown, joumay be azunuiaiig
et I e il P pheons 1 bown laaiibil oowaisn guallly problems A5 e aeanler

aual e phzephons In e soll T eares, e poknlal o 1o moue by e proce sres oTer o lon, s o
lesdtirg Ineare . Te Prosplvaus Keles may be used b dekmile e relake dsk for phosphons kb e
awaker quel Iy proble m oy o .

Trwere are mary arnmplos Balwers iwed ko geake Bz eporl bl make || o gereral e tor delaled
Ttk mareg e plandng. THErepor I ik red 1obe uned I adedrion Lppor oI eenig ool 1 diow
UL oMk 3 U ok eualuakon 3 ko whe B 1 quan| Iy o benls appled snceed s Fe quenily of rLklenl:
UMb by e 0P QoW ong o B, WUennuHents appled sncesd b rLblenis ulzed, pokrad
IrCreaes Tor pUtenE 10leady of Lreartan ST 2 beoome pokilanis of o and $Ude walks

S Mrrepdlls gerera nnahre, do notamame you lmve mel b ol rukeanl rqurieng ayos ag
WMl 37 Tkem, e nwhen Fe rarknl caknin e maare sczads be rabkeniuizalonor be aops
Arown Yo e shamgly eracirgged o meek be servkes ot aprok siaa ratkninaeg anend spedal e
de bmie TRE SpE AT R arrikogen prodplone 3 polaniun el Be resls of By gops grown
INYOLT 0 ITeoie i e 535 kA

Corta! Nakral Resoules Coreerialonderce, Comerake B kralonor Soll Wiskr Corgeniabon Dinc)
slanfal youn ool IS0 A Zervke: Cenler 77 a5t L I aklressiog queshons youmay have relakd ko manre
arvl kel manag emend ony o am .

| Press F1 for Help on &ny Screen | 6/23/2004 | 10:33 AM Y
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Chapter 5 -Reports

AWM generates several different report formats to document the system design. The reports
are generated from File->Reports on the main AWM menu as shown below:

- h:\awm\awmcom puterprgmidesignfiles\awmusermanual. awm

=8 Edit

Data Wiew Tools Window Help
Mew Chrl+1

, . o ™
Open...  ChrHo ?-!1 | it L
Close Animals | pcations Additions Funoff fgrk Train Design Calculator | Manurefaster
Reports Preview Report

Export 4 Print Reporks

Export Repoarts

Save Chrl+3
Save 5.,

Exit

Click on the preferred menu item
in the drop-down list to print,
preview or export a report.

Previewing and Printing a Report
Selecting the Preview Report results in the following screen for the example design:

. Preview Report

[ S hiowt Sub-reports v S

£ b anagemen. Plan
A Designlm

A zubdddiionsLMWg
Aowfzubdnimall ata
A zubClimatel ata
A zubDesignF acilityD ata
A zubDesigrie’aterBudgetD ata
A zublocationD ata

A zubRunoffD ata

A subRunQfPervlmperyD ata
A zubT rainF acilitbyolumelData

Click on the [w Show Sub-reparts
check box to show sub

&hw'sub T rainStepD ata reports.

D Reception Tank

OH Anaercbic Lagoon Data Click on the v Show All States

OH Anaerobic Lagoon Ok

OH MMP Input Data check box to show state

OH Stacking Facilit_l,l [rata custom reports.

OH Stacking Facility 0%k

Bl el el LT (P Click on areport to highlight
OH Storage Pond Ok . .

OH Tank Data it and then click on the

OH Tank D&M Preview ]
OHsubkMPAnimalD ata - button to preview
OHzubkMPD ata . .

OHsubMMPD ataT otals the highlighted report.

Cancel | Preview
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Selecting the Animal Waste Management Plan report to preview results in the following

screen for the example design:

Security Warning @

Cpening "CProgram FilesUSha) st 1avm_data,mdb"

This file may not be safe if it contains code that was intended ko
cornpuker,
Do wiou wank to open this file or cancel the operation?

J|

|_ Cancel En

=

/

Ready LM

! File ‘Window Help
| Expu:urt....*,ﬁu (ST -8 X
N\
i\ Waste M anagenerd Flan
[ 24L:
_— '

Farm Infermation —

Climnade Daka

Andny al Daka
pege: 1€ [ 1 0 I01]

A security warning popup
may appear. Simply click
Qpen ]

on the
button to view the report.

Click on the '® button to
view the report as arich
text format (.RTF) file in
Microsoft Word. The report
can also be saved as arich
text format or document
(.doc) file using Microsoft
Word.

&

Use the zoom & tool to
click on the report to zoom
in or out on the report.

Click on the & button to
print the report to the
default Windows printer.
Use the File menu or press
the [Ctrl] + [P] to select a
different printer to print the
report with.

Use the 4] 2 [ (]

buttons to preview different
ages of the report. The

button previews the
next page and the KD
button previews the
previous page. The [*]
button goes to the last
page in the report and the
4] button goes to the first
page in the report.

The AWM program uses Microsoft Access to preview and print a report. Using the export
tools within Microsoft Access the user can export a report to a Microsoft Word or Excel file
so it can be formatted and saved by the user. The only limitation to creating custom reports
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for use in the AWM program is the user’s knowledge level on how to create and edit reports
using Microsoft Access.

To print a report, select the Print Reports from the Reports menu as shown on the following
screen:

w AWM - h:l\awmawmcomputerprgmidesignfiles\awmusermanual. awm
GIEN Edit Data Wiew Tools Window Help

[{ = Chrl+1
Cpen...  ChrO t s EEE

Close i i Mgmk Train Caleulator
Preview Repart

Export Repoarts t\l\

ManureMaster

Save ks
Save fs, .,

Exit

Selecting the Print Reports results in the following screen for the example design:

| Print Reporis

[v wahow Sub-reports W Show Al States

tanayement Plan
[ AW Dezignlm
[] A zubddditionzCieg
[] A zubdnimalD ata
[] A zubClimatel ata
[ A zubDesignF aciliteDr ata
[ A zubD esigrisd aterB udgetD a\a
[ AwfzublocationD ata
[] A zubRunaffD ata
[] A zubRunO fPervimpervD ata
[] A zubT rainF aciliy olumeD ata

Click on the v Show Sub-reparts

check box to show sub
reports.

Click on the W Show All States
check box to show state

[] AW zubT rainStephata custom reports.

[ WD Reception T ank, : . .

| OH Anasrobic Lagoon Data _Cllck on a report to highlight
[] OH Anaerobic Lagaon 0% it and then click on the

[10OH MMP Input D ata FPrint | .

| OH Stacking Facilty Data ———Ibutton to print the
|1 OH Stacking Facility D& highlighted report.

[10OH Storage Pond D ata =
[10H Storage Pond Ok
[10H Tank Drata
[10H Tank O&k

W

Cancel |
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AWM MMP Input Report

This report can be used to manually transfer data to the Purdue Manure Management Planner
(MMP) program. The NRCS Animal Waste Management (AWM) program is used to analyze
the capacity of an existing manure storage facility or to size a new facility. The design inputs
for the AWM are:

Number & type of livestock (has option of manure production tables)

Bedding (uses table of effective density for bedding types)

Wastewater

Surface area of contributing runoff (calculates monthly rainfall volume based on
county rainfall tables)

In addition the AWM calculates the volume of runoff & rainfall resulting from a 24 hr- 25 yr
frequency storm.

The MMP program is used to determine nutrient allocations for fields receiving manure. The
design inputs to determine manure production volume are:

e Number & type of livestock (can share a common table with the AWM)

e Bedding

e \Wastewater

By default the MMP estimates the rainfall volume appropriate for the type of storage facility
and calculates “estimated manure production” as displayed in the “analysis” tab. From this
estimated total manure volume the MMP then displays nutrient concentrations on the
analysis tab.

In the “storage tab” the MMP has a calculator that can be used to determine the volume of an
existing storage facility. The MMP then uses the storage volume, manure production
volumes, and manure application schedule in a mass balance to develop the nutrient
management plan.

The differences in the AWM and MMP become apparent with the design of a manure storage
facility that is subject to runoff inputs. This is because the MMP estimates the runoff and
rainfall entering a storage facility. Thus, the most accurate assessment of a storage pumpable
capacity and measured annual production volume is when the AWM is used to calculate the
total annual production and storage capacity, and generate a report with the data by the
AWM to be inputted into the MMP. These are the steps:

e Run the AWM to determine the storage volume of an existing facility or to size a
planned facility.

e Once the size of the facility(s) is (are) determined; open and print the “AWM MMP
input” report from the “file”, “report”, “preview report” tab in the AWM. This report
shows:

o0 Annual manure production linked to each manure storage facility (excludes
volume from the 25-yr storm)

o0 Design Storage capacity of each facility (excludes volume from the 25-yr
storm)

o Annual raw manure production volume from livestock (this data is shown for
comparison to raw manure data displayed in the MMP so the user can verify
the selected manure source table)
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e Open the “Animals” tab in the MMP. Populate the columns with the same animals
used to run the AWM; however, do not populate the “extra water” and “bedding”
columns. The MMP will use this data to estimate manure production and nutrient
concentrations and display the data in the “Analysis tab”.

e Open the MMP “Storage tab”. Populate each column with the same “storage 1D and
“Storage type” from the “AWM MMP input” report. Then enter the “Spreadable or
Pumpable capacity” for each identified storage facility.

e Open the MMP “Analysis tab” and enter the “Measured Manure Production” volume
from the “AWM MMP input” report into the MMP “Measured Manure Production”
column. Note that the MMP will then recalculate nutrient concentrations based upon
raw manure data, measured manure production, and default value storage nutrient
loss.

e Continue running the MMP as usual. The program will now more accurately be able
to balance manure production & storage to manure removed for land application.

MMP Analysis Tab

__jManure Management Planner - OH-dairy_2ponds_mm.mmp

General' Fields |Assessment SoilTests' Crops | Storage'AnimaIs' Ratians  Analysis |Equipment Mutrient Mgmt

Storage 1D Mess- | Meas. | Meas. | Meas. | Meas. | Meas. | Meas. Analysis Meas. Measured Production Source And Date Of Manurﬂ
ured | NH4-M | Taotal Total M. Avail. | Awail. Units: % Dry Manure Units
Tatal M P205 K20 | Avail M| P205 K20 Iatter Production
» | pond 1.0 185 19.1 |LbA000Gal 5,800 B85 | GalfYear annual manure volurme from AWk
L« | ;l_l
ew | Open Close Save Save As Tools ? Help About | Ezxit |

|St0rage's estimated manure analysis for tatal M.

fi}Startl & O B » 5 c\program Fles\USD. .. | @ Manure Management ... ”! Manure Manageme... |@ D% M@ 940 8m
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MMP Storage Tab

5,800 685

1,000,000

1 yr. storage of manure, bedding & rainfall onto pond {milkhouse & runoff to 2
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MMP Input Data from AWM for:

Assisted by: MJIM
Measured Annual Manure Production (for MMP "'Analysis"" tab)

700 dairy - 1 pond

Annual Throughput
Volume w/o 25Yr

Facility Manure Bedding Wash Water  Flush Water Runoff Rainfall Rainfall and Runoff
Tons Gallons Tons Gallons Gallons Gallons Gallons Gallons Tons Gallons
Storage Pond NA 4560970 NA 504088 2818000 0 842098 840680 NA 9565836
#1
Annual Total 0 4,560,970 0 504,088 2,818,000 0 842,098 840,680 0 9,565,836
- (R} (1] )
Spreadable or Pumpable Capacity (for MMP ''Storage'" tab) Design Volume w/o
Design Storage 25Yr Rainfall
and
Facility Manure Bedding Wash Water  Flush Water Runoff Rainfall Period Runoff
Tons Gallons Tons Gallons Gallons Gallons Gallons Gallons Months Tons Gallons
Storage Pond NA 4560970 NA 504088 2818000 0 842098 840680 12 NA 9565836
#1
Animal Production Data Manure Produced
per Animal Unit ~ Total Manure
in CF/Day Produced in Annual Manure  Annual Manure
Animal Type of Animal Number Weight in Lb CF/Day Produced in CF Produced in Gal
Lactating Cow Dairy 700 1400 1.70 1666.00 609,756 4,560,975
Totals 700 N/A N/A 1666.00 609,756 4,560,975
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Determining storage volume of an existing facility
This is a trial and error process;

1. First input animals, bedding, wastewater and any other production inputs as they
exist.

2. Designate the storage type in the Mgmt Train screen

3. Size the storage to match the existing component dimensions. Field inventory work
or as-built construction drawings will be needed.

If the storage dimensions can NOT be matched with the current production inputs then use
the production information to obtain the Measured Annual Production volume needed for
MMP (Analysis Tab).

Trial 2 for sizing an existing storage component;

1. From the previous information clear out all the bedding, wastewater and any other
production inputs to zero, while maintaining a storage period of at least 6-months.
Keep the animal input information to work from. In the design screen click on the
Animals screen so you can view both screens at the same time.

il AWM - C:AAWMAExisting Storage Example. awm |Z”El[zl

File Edit Data View Tools Window Help
&y | e m
i E8i)
Design Calculator

Start Climate Animals Locations

.y

o,
Mamt Train

ManureMaster

]
Runoff

Additions

Storage Pond #1 ]

Input Data Cross Section
Shape: Rectangle - Critical Manths: DOct - Mar  BotWw/ L 400x 4236t Top' s L. 100044836 ft

Facility Options

10.0

Total Depth l I Include Soil Liner I Include Ramp
Input Dimenzion: | Bottom ‘Width ~ +

Batom'width |40 f e—— TL =436 Rt

Permanent Add! Freeboard = 1.0 ft

At Animals

Enter quantity and average weight of animals: Select Animal Mew Animal | Delete Selected Row

Animal | Quantity | Weight Manure Vs TS Manure V5 TS Manure
Type Ibe cu.ft/dapsAll | Ibs/dapfall | Ibs/dap/All | cu ft/day Ibs/day Ibs/day Ibe/day
Lactating Cow Dairy 500{ 1400 1.70| 8.50 | 1000| 1190.00| 5950.00| 7000.00) 7140000
Totals 500 N/A | N/A | wa | wa | 1000 5950000  7000.00)  71400.00|

Animal

AU = Animal Unit

V5 = Volatile Solids =
T5 = Total Solids

2. Now manipulate the number of animals in the animal screen to obtain the existing
storage dimensions. As you change the animal numbers the storage dimensions will
change in the design screen. For this example the storage pond is 10 ft deep, 3:1
sideslopes, 100ft x 200ft top dimensions. Through trial and error by changing the
animal numbers you can get within .3ft of a foot to the actual storage dimensions of
the existing structure.
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= AWM - C:\VAWMAEXisting Storage Example.awm

Fi Edit Data ‘iew Tools Window Help

Sl | g & | B | &

Climate Animals Laocations Additions Funoff Mgt Train Caleulstor | Manuretaster

s Design Waste Storage Structures

Storage Pond #1 I

Input Data Cross Section

Shape: IRectangIe _I Critical Manths: DOct - Mar  BotW/ =L 400%139.9f Top' s L.:1000%199.9 1

IW Facility Options
Total Depth ft lrl_ Include il Liner I Include Ramp

Input Dirmension: IBoqu Width vl

Bottarn width |“'1“ ft e TL=-199.9f

Permanent Add! Freeboard = 1.0 ft

A" Animals

Enter quantity and average weight of animals: [ Select Arimal I Mew Airnal | Delete Selected Row |

Animal | Quantity | Weight Manure V5 TS Manure V5 TS5

Animal

Manure

Type Ibs cu.ft/day/AU | Ibs/day/AU | Ibs/day/AU | cu.ft/day Ibs/day Ibs/day

Ibs/day

Lactating Cow Dairy 182 1400 1.70 8.50 10.00 43316 2165.80 2548 00

2598960

Totals 182| N/A N/A N/A N/A 433.16 2165.80 2548.00

25989.60

Al = Animal Unit
¥5 = Volatile Solids
T5 = Total Solids

3. Once you obtain the existing storage dimensions then run the AWM MMP Input
Report to obtain the Spreadable or Pumpable Capacity (for MMP “Storage” tab), or
you can run the AWM Storage Pond Data report to obtain the same information.
Keep in mind that the production volumes are incorrect and through trial and error we

are obtaining only the storage capacity information.

4. The use of AWM through this method of sizing an existing storage facility is limited
to the conventional storage shapes within AWM. Other software such as AutoCAD
maybe better utilized for none conventional storage shapes in estimating storage

capacities of existing facilities.
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Tools

View Wwindow  Help

e

Mamt Train

=

Desian

o
Additions Calculator | ManureMaster

Climate Locations

s Design Waste Storage Structures
Storage Pond #1 I
Preview Report

~ Input Data

[~ Show Sub-reports I~ Show &l States

wl:1000x 1999 f

Total Depth IW
Input Dimenszion: W
W

Shape:

Alwb Anaerobic Lagoon Data
AlwfM Anaerobic Lagoon D&M
AWM Animal Waste Management Plan

Lt
A/ Nutrignt Balance
Awb Stacking Facility Data
Ab Stacking Facility O&hd
Ahwib Storage Pond Data
At Storage Pond O&M
AWM Tank Data
AWM Tank O&M

Bottom width

Permanent Add]

Selected Row |
T5

Enter quantity and average we

Animal

Manure

Animal

Type Ibs/day

Ibs/day

Lactating Cow Dairy 2548.00

25989.60

Totals 2548.00

2598960

Lancel FEreview I
Help QK. |

AU = Animal Unit
V5 = Volatile Solids
T5 = Total Solids

5]

[ | 7542007

Press F1 for Help on Any Screen

AWM MMP Input.rtf - Microsoft Word

[235PM

¢ File Edit Wiew Insert Format  Tools  Table Window Help  Adobe PDF  Acrobat Comments Type a question for help = %
NEE SIS RITE S B S -C8d E GG T 100 - @) HRed
P A4 Hormal +Haett -+ Hasttenschweler - 10 - | B 7 O |
— —
EEL"""i"""'Z"' [ IR T 5 - | s | B -5 | -3 IR
MMP Input Data from AWM for: existing storage
- Assisted By:  str
- Measured Annual Manure Production (for MMP "Analysis" tab)
- Amnual Throughput
- glume L] =
Facility Bedding Wash Water  Flush Waier Runof ainfall Rainfall and Runoff ]
N Tons Callons Callons ‘allons Callos Callons Tons Callons
Storage Pond #1 A 1185849 o 200763 na 1386612
Nl i 1,185,849 o i 200,763
Spreadable or Pumpable Capacity (for MMP "Storage" tab) Design Volume wio
- Design Siorage 25Yr Rainfall and
R Facility Manure Bedding Wash Waier Flush Waier Runoff Rainfall Period Runo L |
- Tons Callons Tons Callons Callons Callons Callons Callons Monshe Tons Callons
© Storage Pond #1 NA 592824 NA i o i o 125138 3 na 718062
- al Mamure  Annual Manure
- Animal Produced inCF  Produced in Cal
Lactating Cow 158,537 1,185,853
- 158,537 ol
- E3
. I3
L.-n ¥
Il 2

Draw = Lz | AutoShapes ~

NANCOOE A B E S- 2 A=
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File Edit Dats View Tools Window Help

s Design Waste Storage §

Storage Pond #1 I

~ Input Data

IHectz
Total Depth |1[I'I]
Input Dimensian: IBottn

Shape:

Marnt Train

tructures

= Preview Report

[ Shaw Subereparts I Show &l States

o
Caleulstar | ManureMaster

vl 1000x 1999 f

AM Anaerobic Lagoon Data

AlwfM Anaerobic Lagoon D&M

AWM Animal Waste Management Plan
At DesignimageD utput

At MMP Input
AWM Nutriient Balance

[+00]

Bottarm width

Permanent Add| A/ Stackil

Ot DM

i)
A/ Tank Dat
Alb Tank D&M
Enter quantity and average we

Animal

Animal
Type

Dairy

Lactating Cow
Totals

Ahw!b Stacking Facility Data
ing Facility &4

Selected Row |
T5
Ibs/day
2548.00
2543.00

Manure

Ibs/day
25989.60
25989.60

Lancel Preview |

Al = Animal Unit
¥5 = Volatile Solids
T5 = Total Solids

BeadBng u..cvoeniiiniiinn

FlushWater

Runoff from Drainage Arec
25Yr-24Hr Storm "
Norrmued Rainfoll ..

Rednfed! ane Pore Surfeece
25Yr24Hr Storm ...
Novmed Reinfodl minis

EVaporttion . e

Accumuiated Solids .

Design Operating Volume ..
Takd Valume of Pand. .........

5 Months

79 268 Cubic Feet
0 Cubic Feet
0 Cubic Feet
0 Cubic Feet

0 Crbic Feat
0 Cibic Feet

B 330 Cubic Feet
16730 Cubic Feet

0 Cubic Feat

95 898 Cubic Feet|
102526 Cubic Feet

Tep Length, TL =
- Top Width, TW =

Crest of Emergency Spilleay

Rectangular Storage Pond #1

199

100 Feet
— 140 Fect

592925 Gallons

0 Gadlans
0 Gedlons

0 Gudlons

Same number for

e Spreadable or
Pumpable Capacity to
ShESd be entered into MMP
125,139 Gallons “Storage” tab
0 Gallons

(ignore manure
production volumes)

718,053 Gallons
769,181 Gudlans

Feat

Minimum Freeboard =1.0 Feet t

Page: |4
Ready

Page 82

Monure=

23Yr-24Hr Storm Preripitation = 040 Feet
25¥r-74Hr Storm Runeff = 0.00 Feet

6 Month Precipitation - Evaporation = 055 Feet
Buneff fram Hemnel Precipitation = 000 TFest
Washwater + Flushwater = 000 Feet

Bedding = 0.00 Feet

7E2 Freat
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Exporting a Report

To export a report to a Microsoft Word rich text format (RTF) file, select the Export Reports
from the Reports menu as shown on the following screen:

w| AWM - h:\awmlawmcomputerprgmidesignfilesiawmusermanual. awm

FIE Edit Data Yiew Tools Window Help

L&

ManureMaster

ga8e
255l
Calculatar

=1

Design

Mew Chrl+M i
L

Cpen... Chrl4+0 ?:’!" I
Close Animals | peations Additions Runoff
Reports Preview Report
Export » Print Repoarts

Export Repoarts
Save Ctrl+35
Save As...
Exit

! File Edit Insert Records ‘Window Help

=3 Export... 3 PR

AvwDesignlmagelutput
AwfzubAdditionzData =
At zubdinimalD ata
SiwfzubClimateData

A subD esignF aciliteD ata
AifzubD esigniw aterBudoetD ata
AiwfzublocationD ata
St zubR unoffD ata
At zubRunOffPery|
AfzubTra) W iolumel ata

.\|<

|E:-:|:u:urt Filez are created in ‘WMF farmat, which iz unedita

' Create one file in BTF for M5 'Word farm

" Create a separate EMF file for each report page

Ew=port to File(s] ...

Farm Yiew MWLM

AWM User Guide

Click on areport to select it
for exporting.

Click on the appropriate L
button to select a Microsoft
Word rich text format
(.RTF) file or EMF file.

Click on the

Ewport ta File(z] ...

button to export the
selected file.
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E=port to File(z] ...

Clicking on the | button results in the following screen

for the example design:

Please Select a Mame for the EMF Files

S P T B Select the directory to
@ ﬁnaerob?c Lagoon. bak. Solids Storage.dwg store the exported report
ﬁnaerotuc Lagoon, dwg Storage Pond.bak . .
My Recent @.ﬂ\nimal ‘Waste Management Plan.rtf Storage Pond. dwg fl Ie n.
Dioumzis @nWMPIan.doc Tank.dwg .
@ B8] v hPlan [ TDisinFeet brmp Enter the file name of the
[ EDisinFeet bmp [ TL-TwinFeet.bmp A

exported report file.

Click on the

button to open the report
in the selected export
file format.

Desktop =] Bw-BLinFest.bmp

Example Design.rkf
Example Manure Master,rtf
OCYDepth,doc

& OHIOPondDesign.bmp
&OHIOTankDesign.bmp
Solids Storage.bak

iy Documents

@

My Computer

) 4
File: narne: I ' 4

My Metwork Files af type: IALL 4
Places

&

j Open
;I Cancel |
% |

[~ Open as read-anly

Clicking on the button results in the following screen for the example design:

izl Animal Waste Management Plan.rif - Microsoft Word

- File Edit  ‘iew Insert Format  Tools Table  Window  Help  Adobe PDF  Acrobat Comments Twpe a question for help = X

NEESf SBY BER oo 4% . ¥ Times Mew Roman  ~ 12 = BE

Sf6 %L M) . FinalShowingMarkup  + Showr Ep r Ep - Xpr e i@-  EH., 'S5 VM B o EEEO?
Y Xor ot otz s a5 e 17 A

ko4
-

Ll s B bk, VS 2 e i

LRV

Page 2 Sec 1 204 A0S Lnil  Col2 REC TRK EXT OvR [BF A

Use the features of the selected program to edit and save the custom report.
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Chapter 6 — Modifying the

AWM Database

The AWM database has four tables, all of which can all be modified. They are:

Note:

Climate
Animals
Bedding
Separators

Changes made to the database do not take affect until AWM is exited and then
restarted.

The tables within the AWM database are accessed from the main AWM menu by first
clicking on Data and then clicking on the table to be modified as illustrated in the following

screen:

w AWM - h:\awmlawmcomputerprgmidesignfiles\awmusermanual. awm [:"E|g|

File Edit

Skart

BEEN Yiew Tools Window Help
Edit Climate Dat i
L e .-." == &
Edit: Animal Data I e LR "ﬁ

Additions Runoff Tgrk Train Design Calculator | ManureMaster

Edit Bedding Data Is Locations

M ocoereio Date —
Select the data table to edit by

clicking on the data element.

If AWM is being used for the first time, the database may not be the most up-to-date
database available. Refer to Chapter 2, Installing and Starting AWM for instructions on how
to download the current database from the NRCS National Water and Climate Center

webpage.
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Editing Climate Data

There are several ways that climate data can be edited or added to the climate data table.
Each method is described in the following instructions.

To edit existing climatic data, select the Data -> Edit Climate Data and the following screen
will appear:

AWM X] Click on the
(]9
‘j : 4 button
! Changes made here will be permanent, / e —

following screen.

«¥ Edit Climate Data

Column Header Descriptions and Units Add Climate Station[s] to Database

251 251 24 Hr. Storm Event [inches] i

JanP - DecP : January to December precipitation values [inches) elatss

JanE - DecE : January to December evaporation values [inches) County: |

Kwal: K value for Clpde Barth Method Lt

Anload : Anaerobic Load Rate [Ibs ¥5/1000 cu. ft/day] Station: |

LRO: Load Rate for Odor [Ibs ¥5/cu. ft/day] )

LR¥Max: Max. Load Rate Yolume (lb: ¥5/cu. ft/day] Import D ata from File | Help | Add |
State | County Skation 25y JanP FetP Mall? | ApiP MawE  [JunP JulP -
OFR  |BAKER HALFwAY O 0 324 23 1.92 1.4 1.37 1.3 04
OFR  |BAKER HUMTINGTO 0 1.78 1.36 1.27 0,81 0.91 0.94 0.3
OR  |BAKER MASON DAM 0 1.91 1.43 1.55 1.09 1.56 1.75 n.a
OR  |BAKER RICHLAMD O 0 1.53 0.9z 0.91 (.95 1.22 1 0&
OR  |BAKER UMITY ORE7 0 1.23 0.69 075 065 1.08 1.14 0.4
OFR  |BEMTOM CORWALLIS 5 0 E.82 5.04 4,55 255 1.95 1.23 0.5
OFR  |BEMTOM CORWALLIS 0o 1202 875 a 3.94 25 1.38 0.4
OR  |CLACKAMAS ESTACADA 2 0 8.53 E.4 .27 477 73 258 1.0
OR  |CLACKAMAS GOVERMMEM 0 1365 1002 8.94 715 464 342 1.1
OR  |CLACKAMAS HEADWORES 0 11.04 874 836 E.E7 5.04 381 1.5

p [OR  |CLACKAMAS M WILLAMET 4 B.17 399 2 64 217 1.73 0|
OR  |CLACKAMAS OREGOM CIT 0 713 5.5\ 478 a4 254 1.91 07
OF  |CLACKAMAS SCOTTS MILL 0 11.597 914 \ 9,23 B.21 4.87 323 1.2
OF  |CLACKAMAS THREE LvMx 0 11.37 8.3 \85 5,36 3.95 2.67 0.
OF  |CLATSOP ASTORIA WS o100 7.54 71X 461 2.0 24 1.1
OF  |CLATSOP SEASIDE OR o 109 913 8.14\ 513 3.56 278 1.5

| I'IFI| CO0 TR LA WERMMMIA 2 M 7Rl RYA RA3 A ? 7R 1RA I'IFi|L

4 3

Page 86

Click on cell to

be edited and
then typein
new value.
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The following screen illustrates how to add a climate station to the climate database:

it Clmate Dat MEE]  Enter State
Column Header Descriptions and Units Add Climate Station[z] to Database — Ab b rev | atl on.
25-Yr: 25-Y1 24 Hr. Storm Event [inches]) orara oR /
JanP - DecP : January to December precipitation values [inches] _ Enter CO u nty
JanE - DecE : January to December evaporation values (inches) East
Kval: K value for Clyde Barth Method Coanty: Nam e.
Anload : Anaerobic Load Rate (lbs ¥5/1000 cu. ft/day) T Mew i
LRO: Load Rate for Odor (Ibs ¥S/cu. ft/day) e T— Enter Climate
LR¥YMax: Max. Load Rate ¥olume [lbs ¥5/cu. ft/day] Import Data from File | Help | dd | — Stat | on Nam e
State | County Station 25-yr JanP FebP MaP  [ApP MayP  [JunP JulP - H
p |[OF  |East Mew 0 0 0 0 0 0 0 :\ CIICk on the
AR |ALASKA ADAK AKOD2 543 4.33 . O] 2.5 27 Add
K |ALAGKA ANGOD - button.
AR |ALASKA GLACIE
ii imgﬁ ng;'& The record has been added with default values of 0. Edit the val¥g in the table, Cl | C k on th e
AK|ALASKA YAKUTA
AK |Aleutians East COLD B, E \ O
A |Aleutians East ST P&l . - - - . . N b
AR Aleutiang West ATTUM AL 0 415 fciral 337 355 254 283 \ u tto n to
AR | Aleutiang West DUTCH HARE i 5,45 613 424 217 213 1.64 B H
AK | Aleutians West SHEMYA LS4 I 2,38 1.88 1.86 1.79 1.65 1.69 2. continue.
AK. |Anchorage ALYESKA AK] a 8.65 5.27 442 45 2.95 252 2. . .
AK_|Anchorage ANCHORAGE o o o749  o0f o0ed  o7d 114 17 Enter climatic
A |Anchorage ELMENDORF a 0.82 0.8 0.79 0.7 0.73 118 19
&K |Bethel BETHEL 'wSs( i 0.59 0.43 0. 0.71 0.79 1.44 1.9 data for the new
AR Rethel rAPF MFWF n 182 10NR 14R 1R3 1R P AR 3 7 1
[« | [ station.

After completing data entry for new climate stations, close the Edit Climate Data screen by

clicking on the &3 in the upper right hand corner of the screen. After exiting and restarting
AWM, the new climate station will have been positioned in alphabetical order by state,
county, and climate station.

Importing Climate Data

You can import climate data from a file that is in comma delimited format. The file must
have all of the fields in the same order as they appear in the climate data table. The file
should not have a header row and should have one climate station per line. The file can have
as many lines as desired. When importing data, if a value already exists in the table, a dialog
box will popup and ask if it is OK replace the value that is in the database.

There are several ways to build a data file for import into AWM. One way is to use
Microsoft Word to develop the data and then save it as a text file(.txt). Another way is to use
Microsoft Excel to develop the data and then save it as a comma delimited file(.csv). The
order of data is State, County, Station, 25-year 24-hour precipitation, January precipitation,
February precipitation, March precipitation, April precipitation, May precipitation, June
precipitation, July precipitation, August precipitation, September precipitation, October
precipitation, November precipitation, December precipitation, January evaporation,
February evaporation, March evaporation, April evaporation, May evaporation, June
evaporation, July evaporation, August evaporation, September evaporation, October
evaporation, November evaporation, December evaporation, Barth’s Kval, anaerobic lagoon
volatile solids loading rate, volatile solids loading rate for odors and Rational Method
maximum anaerobic lagoon volatile solids loading rate.
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An example of one line of climatic data follows:

OR, East, New, 4.00, 6.90, 4.79, 4.33, 2.29, 2.09, 1.39, 0.35, 0.57, 1.46, 3.98, 6.08, 6.85,
0.26, 0.52, 1.04, 1.82, 3.12, 3.90, 5.72, 4.68, 2.86, 1.30, 0.52, 0.26, 0.60, 5.25,
0.0038,0.00625

Each line of the file should have 34 pieces of data separated by commas. The import will fail
if this convention is not precisely followed. A space after the commas may be included or
not used.

The following demonstrates saving the above line of data entered into Microsoft Word as a
text file:

il New. doc - Microsoft Word

File  Edit Wiew Insert Format  Tools Table  Window Help  Adobe PDF Acrobat Comments - X
NEedany Sk Yy B o- 9 100% « 2 TmesMewRoman - 12 - B [E[E = 2
L T R . FinalshowingMarkup v Show- &R p Ep - Kp - (3 - 2 B, OB [ TS I »
|.-E---l---1---l---2---l---3---l---4---l---s---l---é---l---?-A

OF, East, Mew, 4.00, .90, 479 433, 229 209, 139 035,057, 1.44, 398, 608, 5.85,
: 026,052, 1.04, 1.82, 312, 380,572, 4 68, 286, 1.30, 0.52, 0.26, 0.60, 5.25,
- 0.00380.00629
:
: =~
" E3
- o
- ¥
= EEE—-J | ﬂ
Draw~ [3 | Ageshapes~ >~ W [ OE 4l B @ - S2-A- S =2 8B @ .
Page 1 Sec 1 111 ak 1.3" Lm 3 Caol 15 (E7 ]

From the Microsoft Word main menu click on File -> Save As and the following window

will appear: . .
PP Select a directory in

which to save the
in: |@u;erGLnde Ll:f e &l EI'TDDI-S' flle

wn
o
4
@
=]

e

My Documents Type |n flle name

Click on drop-down

] / list and select

Plain Texk (%, bxk)

HlstO;v / Click on the
- A e

Flaces Save a5 bype: |plain Text (#, bl - ancel .
2 Pnfoe o o | to save the file.
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The following demonstrates saving the above line of data entered into Microsoft Excel as a

comma delimited text file:

B3 Microsoft Excel - New. txt

N[(=1[E]

File Edit Wiew Insert Format Tools Data  Window Help  Adobe PDF -7 X
NEEaE SRy @ - @ > i -
ir e CEESO| P E o cE 2 EEE,
- A
A B © D E F G H | J K =l
1 |OR East I e 4 6.9 479 433 229 209 1.39 0.358] T
2
3
4
5
5]
7
&)
3
10
11
12
13
14
15
16
17 e
13
19 %
M4y M\ New / [«] | W[
Draw~ [l ] Auoshapes N N IO E 4 Q@ »-L-A-=E=aBa@.
Ready TR

From the Microsoft Excel main menu click on File -> Save As and the following window

will appear:

= Select the directory
?
i in which to save the

Save in: |hi‘l Iser Guide 5 * Tools * f||e
e
My Douments }r Type in file name.
V -
Bﬂ Click on drop-down
Desktop ¥ list and select
CEY (Comma delimited) (*.csv) |
¥*
Favarites
Click on the
H_]\,:s / | #==  |puttonto
|SCOr .
Y A save thefile.
[=]
gé Fil ! ] - - 1 i
My Mebwork. e |New =id / J =il
Places SEVE a5 Lype: |CS\4I {Comma delimited) (*.csvy A j Cancel
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The following demonstrates importing a climate data .csv file into the AWM database:

¥ Edit Climate Data

Column Header Descriptions and Units

2551 25-Y1 24 Hi. Storm Event [inches)

Kval: K value for Clyde Barth Method

LRO: Load Rate for Odor [lbs ¥5/cu. it/day]

JanP - DecP : Januarmy to December precipitation values [inches)
JanE - DecE : January to December evaporation values [inches]

Anload : Anaerobic Load Rate [lbe ¥5/1000 cu. ft/day]

LAVMax: Max Load Rate Volume [lbs ¥S fcu. ft/day]

S=1ET

Add Climate Stationfs] to Database
State:

County:
Station:

Import D ata from File

Click on

Impart D ata fram File

button.

o

Kl

I ]

This action results in the following

Import File

screen:

Look in; | ) Uszer Guide

&

iy Recent
Documents

¥

Desktop

\$

My Documents

by Computer
“;‘] File narne: |New.csv

My Metwork  Files of type: |CSV Files [*.cav)
Flaces

[ Open az read-only

Change to the
directory where the
file to import is
stored.

Click on drop-down

list and select
C5Y Files [".cav]

Select the file to
import.

Click on the

Oren | putton to

import the file.

The following dialogue box will appear if the file was successfully imported:

1 record(s) imported!

Click L button.

The imported file will appear as the first line for the State in the climate data table. After
exiting and restarting AWM, the records will be resorted into alphabetical order by state,

county and weather station.

A climate file developed in Microsoft Word can also be imported using the same procedure
described for a text file but instead of selecting a ©5¥ (Comma delimited) (*.csv) file type you select

Text Cnly (*.bxt) file type.
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Deleting Climate Data

The following demonstrates how to delete a line of climate station data from the climate data
table:

&% Edit Climate Data

Column Header Descriptions and Units Add Climate Station[z] to Database
25-Y1: 2551 24 Hr. Storm Event [inches]

JanP - DecP : January to December precipitation values [inches] alolcs

JanE - DecE : January to December evaporation values [inches) County: |

Kval: K walue for Clyde Barth Method )

Anload : Anaerobic Load Rate [lbs ¥S5/1000 cu. ft/day] Station: |

LRO: Load Rate for Odor [Ibs ¥5/cu. ft/day] )

LRYMax: Max. Load Rate Yolume [lbs ¥5/cu. It/day] |mpait Data from File | Help | Add |

RUT AL OFF
East MHew
W&EER BAKER Fad A

1.03 062 0.84 0.g2 1.26 1.38 05
BARBRL HaLPwiay OF 3.28 23 1.92 1.4 1.37 1.3 0.4
BAKER \ HUMTIMGTMR 178 13R 1.27 0.21 0.91 0.94 0.3

OR[BAKER  N\\__|M“50 Click here to highlight 1585 103 18§ 175 08

= ) ] e

OF  |BAKER RICHL . . TEY RN 1 0f
OR |BAKER T4 the !lne of climate 078 064 108 114 04
OR  |BENTON coRy Station data to be 455 286 195 123 06
OF |BEMTON corv deleted. g 394 28 138 04
OF  |CLACKAMAS ESTAI Bzf  47q 374 254 10|
OF  |CLACKAMAS GOVE gad 719 484 344 11
OF  |CLACKAMAS HEAD Press the [Delete] key 838  E67 604 381 15
OR  |CLACKAMAS nwiL 0N the computer 3894 264 217  1.73 0.
OFR  |CLACKAMAS OREG keyboard to remove 478 34 25 19 07
OF  |CLACKAMAS 5C0T the line of data. 923 B2 487 3z 1z
NnR 1 ACKARAS THRF 7 AR R AR A9 2R n_-w

|«] | 2N
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Editing the Animal Data

The animal data table can be edited two ways. One way is to edit data that already exist in
the table and the other is to add data. The animal table does not have an import feature.

The following screen illustrates how to edit data in the animal data table:

=% Edit Animal Data

Column Header Deszcriptions and Units

Add Animal to Databaze

MName - Animal Name

Type - Animal Type [Beef. Dairy, Swine, etc)
Manure - Manure volume [cu. ft/dap/AlU])

¥S - Yolatile Solids [Ibs/day/AU)

TS - Total Solids (Ibs/day/Al]

Sluge - Sludge Accumulation Ratio

Iz Lactating - 1 if the animal iz a lactating cow, otherwize 0
Flush Water Yol - Flush Water Yolume [galfday]

Mutrient requirements are estimated by the amount of Mitrogen [M Losses). Ph
Potassium [K. Losses] that is removed from the field by harvesting the crop,

Animal Mame: |

Animal Type: |

Select State: |OR -

orus [P Losses], and

Click on the input
cell and then edit
or replace the
existing data.

tamne Type DataSourc Manure | TS d Sludge |= Lactating Fli &
High Energy Beet WS 118 5 52000 a 0 ]
High Faorage Beet WS 1.33 NE E.3300 a a
Calf Doairy WS U.EY 1.28 0.5600 a a
| D Cow Drainy 9,50 81000 0 0
Heifer Doairy 1.33 9.10 9.0800 a a
Lactating Cow Drainy 1.70 10.00 8.5000 0 0
Horze Horse MWPS 0.80 11.00 9.3600 0 o
Brailer Poultiy hAwfPS 1.50 2380 17.0000 0 I
Diuck Poultiy hAwfPS 083 14.83 28300 0 I
Layer Poultiy hAwfPS 1.00 1628 120000 0 I
Turkey Poultiy hAwfPS o0ya 11.25 2.5600 0 o
K | a8

The following screen illustrates how to delete a animal from the animal data table:

Click here to
highlight
animal line to
be deleted.

Then press
the [Delete]
key on
computer
keyboard to
remove the
line of data
from the
database.
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<% Edit Animal Data

Column Header Descnptions and Units Add Animal to Database

. Amimal Name:
Name - Animal Name

Add Animal

Type - Animal Type [Beel. Dainp. Swine. etc)
Manure - Manure volume [cu. ft/dapfAll)

V5 - Yolatile Sohids [lbs/day/AU)

TS - Taotal Solids [Ibs/day/AL)

Sluge - Sludge Accumulation Ratio

Iz Lactating - 1 if the anmimal iz a lactating cow, otherwize 0
Flush water Yol - Flugh Water Yolume [gal/day]

Amimal Type: |

Select State:  |0R -

Potassium [K Logses) that is removed from the field by harvesting the crop.

Mutrient requirements are estimated by the amount of Nitrogen (M Loszes), Phosphorus [P Losses), and

[

Help

5 1.30 9.50 2.1000

PS

Hame Tupe DataSouwc) Manure [ TS WS Sludge Is Lactating Fl o
High E nergy Besf b P'S 11§ 560 5. 2000 a o
High Forage Besf b PS 1.33 773 E. 3300 a I
Drairy W PS [0.55 1.28 05600 a I
0 o

D airy b 9.0600 a 0
Lactating Cow D airy MFS 1.70 10.00 8.5000 a 0
Harse Horze MuwPS 0.a0 11.00 9.3600 0 0
Broiler Paultry MWPS 1.50 2350 17.0000 a 0
Duck Paltry M PS 0.83 14.83 8.8300 a 0
Lawer Paltry S 1.00 16.25 120000 a 0
Turkey Pavltry MW PS 070 11.25 8.5500 a oo
K I Al
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The following screen illustrates how to add animal data to the animal data table:

=% Edit Animal Data

Column Header Descriptions and Units

Mame - Animal Mame

Type - Animal Type [Beef, Dairp, Swine, etc)
Manure - Manure volume [cu. ft/day/AU)
¥5 - Volatile Solids (Ibs/day/All]

TS - Total Solids (Ibs/day/fAU)

Sluge - S5ludge Accumulation Ratio

Fluzh Water ¥ol - Flush Water Yolume [gal/day)

Mutrient requi tz are

l¢ Lactating - 1 if the animal iz a lactating cow, otherwize 0

ted by the amount of Nitrogen [N Lossze

Enter the name of
the animal to add.

Add Animal to Databaze
Animal Name:

Click here to
Animal Type: access the drop-
Select State: d dOWﬂ |ISt Of

animal types.
Click on an animal
type to select it.

Sheep

Potagsium [K Logges] that is removed from the field by harvesting the l.'.luSJ}‘ine
P ame Tvpe DataSourc| Manure | TS WS Sludge: Iz Lactating El

¥ [High Energy Beef MwPS 116 5E0  5.2000 [ [
High Forage Beef MwWPS 133 774 k5300 [ [ Select a State
Calf Daiy MwWPS 0,56 128 05600 i i from the
Dry Cow Daiy MwPS 1.30 950  &1000 [ i .
Heifer Dairy MWFS 133 310 9.0600 i i dl’OdeWh list and
Lactating Cow Drairy MWwWPS 1.70 10.00 8.5000 0 0 Add Animal
Herse Horse MWwPS 080 1100 93600 i i click on 2 s
Broiler Foultry MwWPS 1 5 2350 17.0000 [ [
Duck Fouly s 083 148% 8o T T button to add the
Laver Poultry MwWPS 1,001 1625 12.0000 [i [i .
Turkey Poultry MW PS 0,70 11.25 85500 i o . animal typ e
() = T =T ks Ao EE [z [z

|« | [ | selected to the

data table.

The added animal is placed on the first line in the data table. The following screen illustrates
an animal named “New Cow” added using the procedure above. Animal data for the “New
Cow” is added by clicking on the appropriate input cell and entering the data.

=% Edit Animal Data

Animal added.

Column Header Descriptions and Units

Name - Animal Name

Manure - Manure volume [cu. t/day/Al)
¥5 - Yolatile Solids [Ibs/fday/AlU)

TS - Total Solids [Ibs/dap/fAU)

Sluge - Sludge Accumulation Ratio

Type - Animal Type [Beef. Dairy. Swine. etc)

Add Animal to Database

Animal Hame:

) Enter animal
Animal Type: |y =, datain accord
Select R v //// with

Iz Lactating - 1 if the animal iz a lactating cew®otherwize 0 d escri ptlo ns
Flush Water ¥ol - Flush Water Volyge*Tgal/day] and units
Nutrient requirements arg ated by the amount of Nitroges osses Phosphgeds [P Lo,
Potassium ?K Loszps at is lemovedyflom the hield b g sting the sfhp. y [ S h own on th e
Mame Type D ataS ourc| Mahure 15 WS Sludge |z L actating Fli & tab I e.
P |Mew Cow D airy HACS 0.00 0.00 0.0000 0 [ p—
Ciowa Beef MWwPS 1.00 7.70 £.0000 0 a
Feeder Calf Beef MWwPS 0.93 7.59 E.4000 0 a
High Energy Beef MWwPS 1.1§ 5.60 5.2000 0 a
High Forage Beef MWwPS 1.33 773 £.9300 0 a
Calf D airy Mw/PS 0.56 1.28 0.5600 0 a
Dy Cow Dairy Mw/PS 1.30 9.50 2.1000 0 a
Heifer Dairy Mw/PS 1.33 310 3.0600 0 a
Lactating [[};w Dairy Mw/PS 1.70 10.00 8.5000 0 a
Horse Horse Mw/PS 0.80 11.00 33600 0 a
Broiler Poultry Mw/PS 1.50 23.50 17.0000 0 o .
K | [

After quitting and restarting the program, the new animal added will be sorted into
alphabetical order by Name and Data Source.

Animals added that are lactating are indicated with a one (1) in the “Is Lactating” column.
This is to associate the animal with a flush water volume indicated in the “Flush Water Vol”
column in the Flush Water Calculator on the Additions Screen.

AWM User Guide

Page 93



Editing the Bedding Data

Editing the bedding data table is very similar to editing the animal data table. Data may be
edited within the data table or new bedding data can be added or existing bedding data
deleted. The following screen illustrates how to add bedding data called “New Bedding”:

=¥ Edit Bedding Data

Column Header Descriptions and Units

Hame - Bedding Hame
Denszity - Denszity of Bedding [lbs/cu. Ft]
Ef. Denszity - Effective Denszity [D g

Add Bedding to Databgs

¥ of Smazhed Bedding - Ibsfcu_ft]

Add T=p

M arme Erizify Eff Densgity State =
p |Mew Bedding E\ 0.00
Corm Taps [shredded] & 11%%&'
Ground Limeztone 100.00 100.0
Legume Hay [chopped] £.50 \13 0o
Legume Hay [looze] 425 am
Monlegume Hay [chopped] .00 12.00
Monlegume Hay [looze] 4.00 a.00
Sand 105.00 10500 &
Sawdust / Shavingz 1050 15,75 8w
Sail 7h.00 7500 A
Straw - Datz [baled) F.a0 18.75 8w
Straw - Wheat [baled] .00 13,20 8%
Straw [baled) 3.00
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Enter the name of
the bedding data
to be added. In
this example “New
Bedding” is being
added.

&dd

Click on
button to add the
“New Bedding”
data. The “New
Bedding” data
appears on first
line.

Enter the density
in pounds per

cubic foot of the
“New Bedding”.

Enter the effective
density of the
“New Bedding” in
pounds per cubic
foot.

Enter the State for
which the “New
Bedding” data is
for.
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The following screen illustrates how to edit existing bedding data:

=¥ Edit Bedding Data E]E|Pz|

Column Header Descriptions and Units

Hame - Bedding Hame
Density - Density of Bedding [lbs/cu. t]

Eff. Density - Effective Density [Density of Smashed Bedding - Ibsfcu.ft] . .
Click on the input

Add Bedding to Databasze cell and then edit
or replace the

Name: &dd | Help |
existing data.
N ame D ensity |Eif Loweff St
Lequme Hay [looze] - £.50
Maonlegume Hay [chopped] B.00 12 .-’-'-.W{

b |Monlegume Hay [looze] 3.00 Ak
Sand 105.00 105,00 &
Sawduzt / Shavings 1050 15,75 4
Sail 7h.00 7500 A
Straw - Datz [baled) 7.h0 18. 75 4%
Straw - Wheat [baled] B.00 1320 8%
Straw [baled) 450 9.00 A
Straw [chopped] F.o0 14,00 &
Straw [lonze] 280 BLO0 A
Wwiood Chips 9.00 1800 &
whond Shavings 9.00 18.0048% o

The following screen demonstrates deleting bedding material from the bedding data table:

=% [ dit Bedding Data EJ[E|E|

Column Header Descriptions and Units
Mame - Bedding Hame
Density - Density of Bedding [Ibs/cu. ft]
. Eff. Denszity - Effective Denszity [Denszity of Smazhed Bedding - Ibsfcu.ft)
Click here to i
. . Add Bedding to Databaze
highlight the row of
the bedding datato | Name: Add | Help |
be deleted.
I arne [ hyzit Eff D enzit State
4
Press the [Delete] Carn Tops [shredded) 4 Al 11,25
key on the Computer Ground Limestone 100.00 100.00 AW —]
keyboard to remove Legume Hay [chopped) B.50 12.00 Ao
. ) Legume Hay [looze) 425 8.80 A
the line of bedding Morlegume Hay [chapped) £.00 12,00 &/
data. MNonlegume Hay [loose] 400 000 A
Sand 105.00 105,00 &
Sawdust / Shavings 10.50 15,75 di
Sail 7h.00 VEL00 &b
Straw - Oatz (baled) .80 18,78
Straw - Wheat [baled) B.00 13,200 o
Straw (baled] 450 9008w o
| « | an
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Editing the Separator Data

The separator data table contains efficiency values for liquid/solid separators by the type of
separator. Data may be edited within the data table, a new separator can be added, or an
existing separator can be deleted. Adding a separator called “New Separator” is
demonstrated on the following screen:

=¥ Edit Separator Data

Column Header Descriptions and Lnits

Mame - Separator Hame
Efficiency - ¥ Efficiency of the zeparal

Add Separator to Databaze

Name: Mew Separator Add 4 Help
I ame 4&;&

P |Mew Separator €
Screw Press 0.30
Setting Bazin 0.70
Static Inclined Screen 015
Static Inclined Screen 12 Mezh 049
Static Inclined Screen 36 Mezh 0.E3
‘Wibrating Screen .45
‘Wibrating Screen 16 Mesh .55
‘Wibrating Screen 18 Mesh 0.35
Wibrating Screen 24 Mesh 0.70
‘Wibrating Screen 30 Mesh .55

Enter the name of the separator
to be added. In this example
“New Separator” is being added.

Click on the 2 | putton to add
the “New Separator” to the data
table.

The “New Separator” will be
added to the data table and will
appear on first line.

Enter the separator efficiency as
a decimal for the “New
Separator”.

Editing the efficiency value for a separator in the data table is illustrated on the following

screen:

=¥ Edit Separator Data

Column Header Descriptions and Lnits

Mame - Separator Hame
Efficiency - ¥ Efficiency of the zeparator

Add Separator to Databaze

Mame: &dd | Help |
M arme Efficiency
Decanter Centrifuge 16-30 gpm 033
Screw Press 020
Setting Bazin 07
Static Inchined Screen 47015

B | Static Inclined Screen 12 Mesh m_

Static Inclined Screen 36 Mesh NES
Wibrating Screen 0.45
Wibrating Screen 16 Mesh .56
Wibrating Screen 18 Mesh 035
Wibrating Screen 24 Mesh Q.70
Wibrating Screen 30 Mesh .56
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Click on the input
cell and then edit
or replace the
existing data.
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Click here to
highlight the row of
the separator data to
be deleted.

Press the [Delete]
key on the computer
keyboard to remove
the line of separator
data.

AWM User Guide

Deleting a line of separator data is illustrated on the following screen:

=¥ Edit Separator Data

Column Header Descriptions and Units

Mame - Separator Hame
Efficiency - % Efficiency of the separator

Add Separator to Database

Mame: | Add | Help |

M ame E fficienc

i’ MHew Separator

Screw Presz

Settling B azin

Static Inclined Screen

Static Inclined Screen 12 Mesh

Static Inclined Screen 36 Mezh

Wibrating Screen

Wibrating Screen 16 Mesh

Wibrating Screen 18 Mesh

Wibrating Screen 24 Mesh

Wibrating Screen 30 Mesh
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